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Overview

1.1

Introduction

Thank you for purchasing a PreSonus® StudioLive™ ARc-series audio interface
analog mixer, the world’s most advanced analog recording system. PreSonus
Audio Electronics has designed the StudioLive ARc-series mixers utilizing highgrade components to ensure optimum performance. Loaded with high-headroom
XMAX microphone preamplifiers; a built-in USB-C™ compatible USB 2.0 recording
and playback engine; parametric EQ on every channel; onboard Bluetooth™
playback; integrated stereo SD recording and playback; a multi-effects processor
with a dedicated mix bus; monitor mixes; extensive LED metering; and more,
StudioLive ARc breaks new boundaries for studio recording and live performance.
All you need are a few microphones and cables, speakers, and your instruments,
and you are ready to mix and record in the studio or in front of a live audience!
We encourage you to contact us with questions or comments regarding
this product. PreSonus Audio Electronics is committed to constant
product improvement, and we value your suggestions highly. We believe
the best way to achieve our goal of constant product improvement is by
listening to the real experts: our valued customers. We appreciate the
support you have shown us through the purchase of this product.
For technical support, please see Section 9.1: Troubleshooting.

1.2

About This Manual
We suggest that you use this manual to familiarize yourself with the features,
applications, and connection procedures before using your StudioLive
ARc-series mixer. This will help you avoid problems during installation and
setup. This manual covers the hardware functions and features of all three
StudioLive ARc-series mixers. When functional differences are called out, the
AR16c will be mentioned first, followed by the AR12c, and then the AR8c.
Licenses and installers for Universal Control, Capture™ and Studio
One® Artist can be found in your My PreSonus user account.
Throughout this manual you will find Power User Tips. These tips provide
mixing tricks, some of which are unique to the StudioLive ARc mixers,
as well as explanations of various audio terms. In addition, you will
find an assortment of audio tutorials throughout this manual.
Thank you, once again, for buying our product. We are confident
that you will enjoy your StudioLive ARc mixer!
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What is in the Box

1.3

In addition to this manual, your StudioLive package contains the following:

• PreSonus StudioLive AR16c, AR12c, or AR8c Audio
Interface / Analog Mixer / Stereo SD Recorder
•

1 meter USB cable

•

IEC power cord

• Rack ear mounting kit (AR16c only. AR8c and AR12c rack ear mounting kits sold
separately)
®
www.presonus.com

StudioLive™ ARc-Series

StudioLive™ ARc

Hybrid Digital/Analog Production Mixers

Mélangeurs de production hybrides numériques/analogiques

Quick Start Guide

Guide de prise en main

StudioLive serie ARc
Consolas híbridas digitales/analógicas para producción

StudioLive™ ARc
系列混合数字/模拟生产调音台

Guía de inicio rápido

快速入门指南

™

• StudioLive ARc-series Quick Start Guide

StudioLive™ ARc-Series
Hybrider Digital/Analog-Produktionsmixer

Kurzanleitung

Getting Started • Para empezar • Erste Schritte • Pour commencer • 入门
You must register online for software downloads,
the Owner’s Manual, and instructional videos.
Go online to my.presonus.com and create — or
log into — your My.PreSonus user account.

Vous devez vous enregistrer en ligne pour
les téléchargements de logiciels, le mode
d’emploi, et des vidéos de formation.
Allez sur my.presonus.com et créez – ou connectezvous à – votre compte utilisateur My.PreSonus.

Debes registrarte en línea para bajar software, el
manual para el usuario y videos didácticos.

您务必在线注册，以下载软件、用户手册和教学视频。

Visita my.presonus.com y regístrate — o entra
usando tu perfil de usuario My.PreSonus.

登录my.presonus.com并创建您的My.PreSonus
用户帐户，或直接登录账号。

Bitte registrieren Sie sich auf unserer Webseite, um auf
die Software-Downloads, die Bedienungsanleitung
und die Anleitungsvideos zuzugreifen.
Öffnen Sie die Webseite my.presonus.com und
erstellen Sie ein neues Konto – oder loggen
Sie sich in Ihren My.PreSonus-Konto ein.

Package Contents • Contenido del paquete • Lieferumfang • Contenu de l’emballage • 打包内容

1.4

What is in your My PreSonus Account
Once you register your StudioLive AR mixer at My.PreSonus.com, you will
find the following software available for download in your user account:
• StudioLive ARc-Series Owners Manual
• Universal Control
• Capture multitrack-recording software
• Studio One Artist DAW software and bundled content
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Getting Started
Before you begin, here are a few general rules of thumb:
• Always turn down the Main, Control Room, and Phones
level controls before making connections.
• Before plugging or unplugging a microphone while other channels
are active, mute the channel to which you are connecting.
• Channel levels should be set on or near the “U” mark whenever possible. The “U”
indicates unity gain, meaning the signal is neither boosted nor attenuated.
• Do not allow your inputs to clip. Watch the signal indicators and make sure
the red Clip indication illuminates rarely, if ever. Clipping (overloading)
the inputs can result in digital distortion, which sounds terrible.
Warning: Engaging phantom power or connecting sources without muting the channels
can result in a very loud pop that can potentially damage your sound equipment.
Always mute your channels before engaging Phantom power or connecting sources.
P.A. and studio equipment should be powered on in the following order:
• Sound sources (keyboards, direct boxes, microphones,
etc.) connected to the StudioLive ARc inputs
• StudioLive ARc mixer
• Computer (if applicable)
• Power amplifiers or powered monitors
When it’s time to power down, your system should be turned off in the reverse
order. Now that you know what not to do, let’s get some audio going!

2.1

Level-Setting Procedure
1.

Grab a microphone and a mic cable and plug them into the
Channel 1 mic input.

2.

Connect the Main outputs of your StudioLive ARc to your power amplifier or
powered monitors.

3.

Bring down all the level controls on your
StudioLive ARc to the lowest setting.

4.

Make sure that the Mic/Line knob on Channel 1 is
turned all the way counter-clockwise.

5.

Plug your StudioLive ARc-series mixer into a power outlet and turn it on.

3
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6.

If your microphone requires phantom power, engage the 48V button on
your StudioLive ARc mixer.

7.

Turn on your amplifier or powered monitors.

8.

Speak or sing into your microphone at approximately the same volume you
expect during the performance.

9.

Turn the trim knob on Channel 1 clockwise while watching the signal
indicator. Adjust the Channel 1 trim knob until the signal/clip indicator is
red, then back down until it is green and just below clipping at the loudest
input level.

10. Raise the Channel 1 level control to unity gain (denoted with a “U”).

11. Bring up the Main level until you can comfortably listen to your microphone
through your speakers.
12. Sculpt the sound by adding EQ to taste.

4
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3.1.1 Inputs
Microphone Inputs. Your StudioLive ARc-series mixer is equipped with high-gain
XMAX microphone preamplifiers for use with all types of microphones.

48-volt Phantom Power. The StudioLive ARc mixers provide global 48V phantom
power for all microphone inputs.
WARNING: Phantom power is required for condenser microphones but can
severely damage some dynamic mics, especially ribbon mics. Therefore, unless
the manufacturer of your dynamic mics clearly states that phantom power will not
damage them, you should use condenser mics only, with phantom power on, or
dynamic mics only, with phantom power off.
Power User Tip: Dynamic microphones and ribbon microphones are generally
lower-output devices and require no external power source. The most important
thing to note about ribbon microphones is that they very rarely require phantom
power. In fact, unless a ribbon microphone calls specifically for phantom power,
sending phantom power to it can cause severe damage. Condenser microphones
are generally more sensitive than dynamic and ribbon microphones and typically
require external +48V phantom power. Always review your microphone’s
documentation to ascertain the manufacturer’s recommended operating practices.
Line-level Inputs. Each channel of your StudioLive ARc-series mixer has a ¼-inch,
balanced TRS connection for line-level input. Typical examples of line-level
connections are synthesizer outputs, CD/DVD-player outputs, and (with exceptions)
signal-processor inputs and outputs.
Note: As with any mixer, plugging in a microphone or a line-level input device, or
turning phantom power on or off, will create a momentary spike in the audio output
of your StudioLive ARc mixer. Because of this, it is highly recommended that you mute
or turn down the channel trim before changing connections or turning phantom
power on or off. This simple step will add years to life of your audio equipment.
Instrument Inputs. Channels 1 and 2 are equipped with an input that can be
switched between line and instrument. Use these ¼-inch connections for
instruments that don’t have internal preamps (guitar, bass, etc.). See Input Source
button in Section 3.2 for more information.
Power User Tip: Active instruments have an internal preamp and a line-level
output. This type of instrument should be plugged into a line input, rather than
an instrument input. Plugging a line-level source into an instrument input risks
damage to the input and results in a very loud and often distorted audio signal.
Insert (AR16c and AR12c). Channels 1 and 2 on the StudioLive AR16c and AR12c
also have inserts. These unbalanced, ¼-inch connectors can be used to connect
external processors (such as compressors, EQs, de-essers, and filters) to the
channel inputs.
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Ring (In)
Tip
(Return)

Tip
(Out)

Insert-connector wiring:
Tip
Ring (Send)
(Return)

From
processor
output

Tip
(Send)

Tip = send (output to inserted device)
Ring = return (input from inserted device)
Sleeve = common ground

To mixer
channel
insert

To
processor
input

3.1.2 Outputs

1

2

3
4
5

6
1. Main. The StudioLive ARc-series mixers feature with XLR main outputs.
2. Control Room. These are the balanced control-room outputs.
The Control Room knob on the top panel controls the level.
3. Phones. This ¼-inch TRS connection is for use with headphones.
The Phones knob on the top panel controls the level.
4. Footswitch. This connection allows you to use an external
footswitch (not included) to mute the effects return.
Power User Tip: Your StudioLive will follow the behavior of the type of footswitch
you use. A latching footswitch allows you to mute the effects return until you
engage the footswitch a second time. A momentary footswitch will allow
you to mute the effects return only while the footswitch is depressed.
5. Aux. The StudioLive ARc-series mixers are equipped with 2/2/1 aux
mix outputs. Aux mixes are routed to these outputs. See Section 3.4
for more information on creating Aux mixes for monitoring.
6. FX. The FX send mix is routed to this output, allowing you to create
an additional monitor mix. When this output is engaged, the internal
effects processor is bypassed. More information about creating effects
mixes and the effects processor can be found in Section 3.5.

6
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3.1.3 Rear Panel Connections
USB-C™ compatible connection. Use this port to connect your StudioLive ARcseries mixer to a USB port on your computer when using the mixer as an audio
interface. See Section 5 for further information. Your StudioLive ARc mixer is a USB 2.0
device and is compatible with nearly all USB connections.
Power-input. Plug in the provided IEC power cable here.

Power switch. Push the top part of the switch to turn on your StudioLive ARc mixer.
Push the bottom part of the switch to turn it off.

3.2

Channel Controls

1
2
3

4
5
6
7
8

9

10
11
12
13

14

1. Input-signal indicator. Each channel features an LED next to the trim control that
illuminates green whenever an input signal is present. The LED color will change to
red if the signal (pre- or post-EQ) reaches -3 dB.
2. Input Gain control. These knobs provide 43 dB of variable gain for mic
inputs and 40 dB of variable gain for line inputs (mono channels only).
3. Input Source button. Channels 1 and 2 offer an Input Source button
that lets you select instrument- or line-level for the ¼-inch inputs
on these channels. Press this button to engage the instrument
preamp when connecting guitars or a passive bass.
Note: Engaging the Instrument preamp will disable the
microphone preamp on the XLR connection.
4. Low Cut Filter (Mono channels only). When engaged, all frequencies
below 100 Hz will be attenuated (cut) at a slope of -18 dB/octave.
Power User Tip: Use the Low Cut filter to remove unwanted low-frequencies
from your source signal, rather than trying to EQ them out.
The stereo channels are equipped with a +10 dB Boost. When engaged,
this raising the level of both the mic and the line inputs by +10 dB.
5. High shelving EQ Gain control. Sets the level of the highband center frequency (10 kHz) from -15 to +15 dB.
Power User Tip: A high shelving EQ is like a treble-control knob on a stereo. In
this mode, the Center Frequency control selects the shelving frequency.
6. Mid peaking EQ frequency control (AR16c and AR12c, mono channels only).
Sets the center frequency of the Mid EQ. You can adjust the center frequency from
140 Hz to 3.5 kHz. This control is available on the Mono input channels only.
7. Mid peaking EQ gain control. Sets the level of the mid-band center frequency
from -15 to +15 dB. The center frequency can be adjusted on the mono inputs of
the AR16c and AR12c. All other inputs and the AR8c have fixed center frequency
at 2.5 kHz.

7
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8. Low shelving EQ gain control. Sets the level of the lowband center frequency (100 Hz) from -15 to +15 dB.

Power User Tip: A low shelving EQ is like a bass-control knob on a stereo. In
this mode, the Center Frequency control selects the shelving frequency.
9. Aux sends. These are the level controls for each channel to the
corresponding aux mix. The AR16c and AR12c provide two aux
mixes, and the AR8c provides one Aux mix. See Section 3.4 for more
information on using the aux bus to create a monitor mix.
10. FX send. This is the level control for each channel for the effects mix.
See Section 3.5 for more information on creating effects mixes.
11. Pan. This sets the channels position in the Main stereo mix.
Power User Tip: Panning can be a great way to achieve better separation
in your main mix. Using pan in conjunction with level will allow you to
create more definition and space between each channel’s signal.
12. Mute button and indicator. This button mutes its channel in all outputs.
The LED to the left of it will illuminate red when the channel is muted.
13. PFL (Pre-Fader Listen) button. This button will solo its channel to
the Control Room and Headphone outputs, pre-fader. When no PFL
button is engaged, the Main mix is routed to these outputs.
Power User Tip: If you can’t hear the main mix or a channel in your
headphones, make sure that PFL is not engaged on an unused channel.
14. Channel level. Controls the overall level of the channel.

3.2.1 Digital Returns
The last stereo channel (15/16, 11/12, 5/6) provides a digital playback streaming
option. The Digital Return button routes playback streams 3 and 4 from your audio
software to this channel. When engaged, the analog source will be bypassed;
however, the signal will still be routed to the digital send so that it can be recorded or
processed by a plug-in. For more information, see your StudioLive ARc-series
Software Reference Manual in your My PreSonus account.
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The Super Channel
1

2

Each StudioLive ARc-series mixer features a unique Super Channel that allows you to
connect several analog and digital sources at once so you can get the most out of
your mixer.
1. RCA inputs. These unbalanced inputs allow you to connect a stereo
line-level device, such as a Blu-ray player or karaoke machine.
2. 1/8-inch stereo input. This is an unbalanced, stereo, 1/8-inch
connection for line-level devices such as smartphones and tablets.

3

3. USB / SD Card Return. By default, playback for the onboard SD recorder is
routed to the Super Channel. Engaging this button will route USB playback
streams 1-2 to the Super Channel instead. More information on using your
StudioLive ARc-series mixer as an audio interface can be found in the Section 5.
4. Bluetooth Mute. Press this button to mute the Bluetooth source for
your ARc mixer.

4
5

5. Bluetooth pairing. Use this button to pair your Bluetooth device with
your ARc-series mixer. See Section 3.3.1 for pairing instructions.
Power User Tip: All available sources are summed into the Super Channel. Because this
channel only selects line-level devices, the majority of which have onboard level controls,
you can use this channel to expand the input flexibility of your StudioLive ARc-series
mixer.

3.3.1 Pairing a Bluetooth Device
To pair a new device to your StudioLive ARc-series mixer:

Hold 3 sec

1.

Press and hold the Bluetooth pairing button for three seconds.

2.

The Bluetooth button will flash once every second.

3.

Search for new Bluetooth devices from the device to
which you’d like to pair (smartphone, tablet, etc).

4.

Select “StudioLive AR16c/AR12c/AR8c” from the available
Bluetooth devices list on the pairing device.

5.

The Bluetooth button will illuminate solid when paired successfully.

Note: If previously paired, your StudioLive ARc mixer will connect
automatically. The Bluetooth pairing button will flash rapidly (two to
three times per second) while the Bluetooth module detects connected
devices and will illuminate solid when it is successfully paired.

3.4

Aux Buses
The aux bus provides outputs to route auxiliary mixes that are separate from
the main mix. StudioLive ARc-series mixers are equipped with 2/2/1 aux
buses, which have physical output jacks, and one internal effects bus.
Aux buses can be used for many applications, the two most common of which are
creating monitor mixes and inserting external effects processors into the mix.

9
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3.4.1 Monitor Bus Controls
1. AFL button. This button will solo the aux bus to the aux outputs after the fader.

1
2

Power User Tip: Using this control to listen in on a performer’s monitor
mix can be a great way to quickly dial in just the right amount of
each signal and get to a great monitor mix more quickly.
2. Mute button. This button will mute or unmute its aux bus. The LED to
the left of it will illuminate red when the aux bus output is muted.
Power User Tip: Muting an aux bus output during performance breaks is a
quick and easy way to prevent accidental signal spikes or feedback.
3. Output level. Adjusts the master level of the aux output.

3

3.4.2 Creating Monitor Mixes
Creating custom monitor mixes is critical. If musicians can’t hear themselves or their
bandmates, their performances will suffer. A monitor mix can be mono or stereo.
Most often, an individual live monitor mix is mono and is sent to a floor-wedge or
sidefill monitor. (The obvious exception is in-ear monitor systems.) A studio monitor
mix is usually stereo because it is sent to a headphone amplifier that requires both a
left- and a right-channel input. In both cases, the function of the aux bus is the same.
As an example, let’s create a mix for Aux Bus 1:
1.

The Aux 1 send control for each channel sets the send level in the Aux 1 mix.
Use these knobs the same way that you use the output level controls to dial
in your main mix. Ask your musicians what they would like in their monitor
mix and use their requests as a starting point.

2.

Use the Aux 1 Output control to adjust the overall output level.

3.

Press the Aux 1 AFL button to listen to the mix through the headphone or
control room outputs as you make final adjustments to the mix.
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Internal FX Bus
Each StudioLive ARc-series mixer is equipped with an internal
effects processor with 16 effects presets. This section will cover each
preset, as well as how to add and use effects in your mix.

3.5.1 Effects Presets

To select an effects preset, simply turn the encoder until the
desired preset number is displayed and press the encoder.
Preset Descriptions and Uses
No.

Name

Description

When to Use

1

Small Hall

Adds a medium reverb time to emulate a
small concert hall

• Gives vocals and instruments a “big” vibe
• Adds a greater sense of space

2

Concert Hall

Emulates a large concert hall with
softer surfaces

• Adds rich fullness to acoustic instruments
and solo vocals

3

Large Hall

Provides long pre-delay and reverb time

• Gives acoustics instruments and vocals a
“larger than life” feel

4

Cathedral

Emulates a large cathedral by adding long
pre-delays and reflections

5

Studio

Emulates an acoustically treated studio room
to provide a more intimate and warmer tone

• Soften harsh instruments
• Gives vocals a lush vibe
• Adds subtle ambience to a mix

6

Vibrant Room

Emulates the sound of large room with hard
surfaces to provide many early reflections

• Adds life to a flat room
• Helps a vocal or instrument stand out in
a mix

7

Large Club

Warm and full reverb to emulate the sound of
a large acoustic venue

• All purpose reverb for overall mixes

8

Plate

Emulates a vintage plate reverb by providing
many early reflections without pre-delay

• Fattens up percussion and backing vocals

9

Tape Echo

This medium-length, clean delay emulates
the traditional tape echo

• Great for vocals and guitars for a retro vibe

10

Short Delay

Provides 300 ms delay

• Helps a vocal or guitar cut through a mix

11

Medium Delay

Provides 380 ms delay

• Adds drama to a vocal or sample

12

Long Delay

Provides 480 ms delay

• Subtle, dreamy effect for vocals and
instruments

13

Endless Delay

Combines a large room reverb with
a long delay

14

Slapback

Adds a single, relatively quick delay of the
original signal to emulate vintage tapebased delay units

15

Chorus

Plays with the phase of the signal to create a
modulated, sweeping effect

16

Sweeping Reverb

Adds a rich reverb to a chorus effect

• Adds a rich, ethereal feel to any instrument

• Because Purple Rain
• Vintage sound for guitars
• Fun effect for vocals
• Good effect for electric guitar and keyboards for a vintage vibe
• Thickens and enhances instruments
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3.5.2 Internal FX Bus Return
The internal FX return allows you to adjust the amount of the effects
output you would like in your main and monitor mixes.
1

1. Aux sends. These are the level controls for the effects output in each aux
mix. The AR16c and AR12c provide two aux mixes; the AR8c provides one
aux mix. See Section 3.4.2 for more information on creating aux mixes.
2. Balance. This sets the FX return’s position in the main stereo mix.

2
3

3. Mute button. This button will mute or unmute the FX return. The LED
to the left of it will illuminate red when the FX output is muted.
Power User Tip: Mute the FX return during performance breaks while the
band is speaking to the audience to create a more professional show.
4. FX level. Adjusts the master level of the effects output in your main mix.

4

3.5.3 Creating Internal Effects Mixes
There are at least two main advantages to creating an effects mix, rather than
inserting an effect in a channel. First, several channels can be sent to a single
processor. In addition to greatly simplifying the number of parameters you
have to control, this can create a cohesive sound in your mix. The second
advantage of creating an effects mix is that you can vary the level sent from
each channel to the processor, rather than patching the output directly into the
effect. This allows you to add a lot or a little of an effect to any given channel.
Your StudioLive ARc-series mixer’s internal effects bus is used much in
the same way the aux buses are used to create monitor mixes.
1.

To begin, select the effects preset you would like to use by turning the
Effects encoder to the desired number and pressing the encoder.

2.

Raise the FX return output level to unity.

TURN, THEN PRESS
TO SELECT
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3.

Use the FX send controls on each channel the same way that you use the
faders to set the output level to your main mix. The higher a channel’s
level is in the effects mix, the more processed (“wetter”) it will sound.
Let’s say that you are using reverb to liven up a relatively dead room.
You might send a little bit of each input to the reverb, but you probably
will not want much of the drums and bass to be processed, as too
much reverb could reduce their impact and leave your mix without
a sturdy foundation. So rather than turning the FX-send level for the
kick drum channel all the way up, turn it to the 8 or 9 o’clock position,
so that its saturation is between 20% and 30%. This way, only a small
portion of the kick-drum input will be affected by the reverb.

4.

Use the FX return level fader to increase or decrease
the overall effects mix in the Mains to taste.

5.

To send the FX return mix to a monitor mix, adjust the
FX return’s monitor send control to taste.

3.5.4 Using an External Effects Processor
This section will detail how to use an external effects processor,
bypassing your StudioLive ARc mixer’s internal processor.
1. To begin, connect the FX output to the input of your external
effects processor and connect the outputs of your processor
to a stereo channel on your StudioLive ARc mixer.
MIC INPUT

LINE INPUT
MONO
Balanced Input

BALANCED OUTPUTS
LEFT

RIGHT

DIGITAL I/O
DI

MIDI
IN

THRU

PEDAL
OUT

IN

S/PDIF
DO

2. Turn up the output level of the stereo channel to unity.
3. Use the FX send controls on each channel the same way that you use the
faders to set the output level to your main mix. The higher a channel’s
level is in the effects mix, the more processed (“wetter”) it will sound.
4. Use the stereo channel’s Level control to increase or decrease
the overall effects mix in the Mains to taste.
5. To send the FX return mix to a monitor mix, adjust the
stereo channel’s monitor send control to taste.
Power User Tip: You can also use the FX output to create an additional monitor mix
when multiple monitor mixes are of greater importance than adding effects.
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Master Section Controls
1
2

1. USB 1-2 Send. By default, the main mix can be recorded to your computer on the
last USB send pair (17-18 / 13-14 / 7-8). If you are only recording the main mix on
your computer, engaging the USB 1-2 Send button will simplify setup in most
situations.
Note: When this button is enabled, Channels 1 and 2 cannot be recorded
individually, although they will still be a part of the Main mix.
2. Main Mute button. This
button will mute or unmute the Main bus. The LED to the left of
it will illuminate red when the main outputs are muted.

3

Power User Tip: Muting the main mix during performance breaks is a
quick and easy way to prevent accidental signal spikes or feedback.
3. Output-level control. Adjusts the master level
of the Main output.
4. Main output meters. These peak meters display the output levels of the main
stereo bus. These meters are scaled from -24 to +15 dBu. For best performance, the
highest level of your mix should stay between the “0” and “+6” indicators.
Because the StudioLive ARc mixer main outputs
are electrical, rather than digital, it is more advantageous to meter them
relative to voltage. The Main meters display signals from -24 to +15 dBu
(-42 to -3 dBFS). This means that if you play back a digital signal over USB
or from the SD card at -18 dBFS, it will register in the Main meters as 0 dBu.
Conversely if you record a signal over USB that registers at 0 dBu in the Main
Meters, it will display at -18 dBFS in any application that meters in dBFS.

3.6.1 Control Room Levels
StudioLive ARc-series mixers feature a headphone output and controlroom outputs, allowing you to listen to the main mix and the Solo
bus. Whenever a channel is soloed, it will automatically be routed
to the control room and headphone outputs. When no channel is
soloed, the main mix will be heard through these outputs.

1

2

3

1. PFL / AFL Master knob. Adjusts the overall level of the Solo bus.
2. Control Room knob. Adjusts the overall level of
the control-room monitor outputs.

14

3
3.7

StudioLive™ ARc Series
Owner’s Manual

Hookup
Typical Band Setup Diagram

3. Phones knob. Adjusts the overall level of the headphone output.

3.7

Typical Band Setup Diagram
Electric guitar amp
Bass

Lead vocal

Drum kit

Front of house
speakers

Keyboard
Music
Playback

Floor wedges

Laptop running Capture
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Typical Home Studio Setup Diagram
Guitar

Keyboard

Main reference

Mic
Micro-synth
Phones

Headphone amp

Phones

Laptop running Studio One
or 3rd party DAW
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SD Recording and Playback
StudioLive ARc-series mixers are equipped with an onboard stereo SD recorder
that allows you to record the main mix as a stereo WAV file to any FAT16formatted SD card or FAT32-formatted SDHC card. You can also load stereo
WAV and MP3 files onto an SD or SDHC card to play audio during a show.

4.1

SD Recording
This section explains on how to record the main mix as a stereo WAV file:
1.

Insert a FAT16-formatted SD card or FAT32-formatted SDHC card into your
StudioLive ARc mixer. An SD card will provide up to 2 GB of storage space.
An SDHC card will provide up to 32 GB.

2.

Press the Record button.

3.

Recording will begin when the Play/Pause and
Record buttons are both illuminated.

SD Card

If no SD card is recognized, the Record button will flash three times.
4.

Press the Play/Pause button to stop the recording.
Once complete, you can transfer your recordings onto your computer by
inserting the SD card into your computer’s SD card reader and copying the
files to your computer’s hard drive. Each file will be labeled with an “SL-ARc”
heading, followed by a number.

17

4
4.2

4.2

SD Recording and Playback
SD Playback

StudioLive™ ARc Series
Owner’s Manual

SD Playback
Playing files from the SD card is a great way to listen to a performance right
away, and it can be useful during a performance. SD cards can be preloaded with
backing tracks for performance or rehearsal. Or load an SD card with your favorite
break music and never be caught without the right adapter or cable again.
To play audio from your SD recorder:
1.

Insert into your StudioLive ARc mixer a FAT16-formatted SD card or FAT32formatted SDHC card that has been pre-loaded with WAV or MP3 files or
that you have recorded to using your StudioLive ARc mixer.

2.

Press the Play/Pause button. The current stereo audio file will begin to play
at the last position. Playback will continue through all files, in alphanumeric
order, until the end of the last file has been reached; then playback will stop
automatically.

3.

Press the Play/Pause button again to pause
playback at the current file position.

4.

Press the Return to Zero button to restart the current audio file. Press again
to move to the beginning of the previous file.

5.

Press the Go to End button to advance playback to the end of the current
audio file. Press again to move to the end of the next file.

SD Card
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Connecting to a Computer
Connecting your StudioLive ARc mixer to your computer is quick and easy. For Mac
users, just connect your mixer to a free USB connection on your computer and you’re
ready to go. For Windows users, you must first install Universal Control. This will install
both the ASIO/WDM driver and the control panel for your StudioLive ARc-series
mixers. We made this installer as simple and easy to follow as possible, and it will take
you through each step of the installation process. Please read each message carefully
to ensure the StudioLive driver and the control panel are properly installed. In
particular, be careful not to connect your StudioLive mixer to the computer too soon.
Please visit www.presonus.com for the latest system requirements
and an updated list of compatible hardware. It is also recommend
that you check your recording software’s system requirements.
Power User Tip: The speed of your processor, amount of RAM, and
capacity, size, and speed of your hard drives will greatly affect the overall
performance of your recording system. A faster processor and more RAM
can reduce signal latency (delay) and improve overall performance.

5.1

Installation for Windows
Before beginning the installation setup, please quit all applications, including
antivirus software, and disconnect the StudioLive mixer from your computer.
Follow the onscreen instructions to complete the installation. When the
installer has finished, it will prompt you to reboot your computer.

Click “Finish” to automatically restart your PC. Once your computer has
rebooted, connect the StudioLive. When the Found New Hardware wizard
launches, follow the “Recommended” steps.

Your StudioLive is now synced to your computer and ready to use!
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5.1.1 Universal Control (Windows only)

Sample Rate. Changes the sample rate.
You can set the sample rate to 44.1, 48, 88.2, or 96 kHz. A higher sample
rate will increase the fidelity of the recording but will increase the file size
and the amount of system resources necessary to process the audio.
Safe Mode. Adjusts the Input Buffer Size.
These modes allow you to adjust the input buffer size
to optimize performance for your computer.
When adjusting the safe mode, the block size will be adjusted
automatically to provide the best performance.
Block Size. Sets the buffer size.
From this menu, you can set the buffer size from 16 to 4,096 samples (Mac), or 64
to 8192 samples (Windows). Lowering the buffer size will lower latency; however,
this will also increase performance demands on your computer. In general, you will
want to set the buffer size as low as your system can safely support. If you begin
to hear pops, clicks, or distortion in your audio path, try raising the buffer size.
Note: When adjusting the block size, the Safe Mode will
automatically change to provide the best performance.

5.1.2 Loopback Recording (Windows only)
The windows drivers for the StudioLive ARc-series mixers provide two
virtual streams that allow you to record the output of on audio application
in another application. Loopback can be useful in a variety of situations:
• Recording the audio from a video game or YouTube
video for a podcast or livestream.
• Recording a vocal in real time over a karaoke track
played from a web browser or media player.
Power User Tip: Because the StudioLive ARc-series mixers are class compliant Core
Audio devices, these virtual streams are not available in macOS. However, there
are several third-party applications that provide this functionality in macOS.
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From Universal Control, you can enable or disable Loopback and pick
the streams on which the loopback audio will be recorded.
When Loopback is enabled and “Merge Loopback with 1/2” is selected,
the audio from another application will be recorded with the audio source
connected to analog inputs 1 and 2 on your StudioLive ARc-series mixer.

Media Player
Web Browser
Etc.

When Loopback is enabled and “Virtual” is selected, the audio
from another application will be recorded on the last pair of
driver inputs (AR8c: 9/10, AR12c: 15/16, AR16c: 19/20).

Media Player
Web Browser
Etc.

Power User Tip: When using either option, you will need to select Outputs 1 and
2 in the audio application your want to record. Make sure to select Outputs 3 and
4 in the audio application in which your recording to avoid a feedback loop.
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5.1.3 Using the StudioLive for System Sound
Click on the small speaker icon in the bottom right corner
of the screen and select “Playback Devices.”

Select StudioLive ARc playback channels 1/2. This will route your
system audio to the USB return on the Super Channel of your mixer.
Select “Set Default” at the bottom of the screen and click OK.

Now that your StudioLive ARc-series mixer is setup as the default playback
device for your computer’s operating system you can use it for basic playback
from your computer via your media player or from your Internet browser.
To playback system audio from your computer through your mixer, press the USB/SD
Card Return button on the Super Channel and make sure it is in the down position.
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Installation for macOS
The StudioLive ARc mixers are class compliant audio devices in macOS. No
installation is required. Just connect your mixer to a free USB connection

5.2.1 Using the StudioLive for System Sound
You can configure your StudioLive ARc-series mixer as the
audio interface for computer system audio (for iTune playback,
Skype, etc.) from the System Preferences menu.
1.

Open System Preferences

2.

Open your System Sound Preferences

3.

Select your StudioLive ARc-series mixer from the Outputs
list. If you would like to use your StudioLive mixer for
System input, select it from the inputs tab as well.

To playback system audio from your computer through your mixer, press the USB/SD
Card Return button on the Super Channel and make
sure it is in the down position.
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Using the StudioLive with Popular Audio Applications
Below are basic driver-setup instructions for several popular audio
applications. Complete setup instructions for PreSonus Studio One Artist
and a brief tutorial on its features are located in Section 7 of this manual.

Steinberg Cubase 4+
1. Launch Cubase.
2. Go to Devices | Device Setup.
3. Select “VST Audio System” from the Devices column in the Device Setup.
4. Select PreSonus FireStudio from the ASIO Driver dropdown list.
5. Click “Switch” to begin using the StudioLive Driver.
6. Once you have successfully changed the driver, go to Devices |
VST Connections to enable your input and output buses.
Ableton Live 5+
1. Launch Ableton Live.
2. Go to Options | Preferences | Audio.
3. Choose Driver Type: ASIO | Audio Device: ASIO PreSonus StudioLive ARc
4. Go to Input Config : Enable and select the desired Input channels.
5. Go to Output Config : Enable and select the desired Output channels.
6. You may now select the StudioLive’s inputs and
outputs for each track created in Live.
Apple Logic Pro/Express 7+:
1. Launch Logic Pro/Express.
2. Go to Logic | Preferences | Audio.
3. Click on the Devices Tab.
4. On the Core Audio tab, check Enabled.
5. Select PreSonus StudioLive ARc from the device menu.
6. You will be asked if you’d like to relaunch Logic. Click “try (re)launch.”
7. Your StudioLive features custom I/O labels for faster work flow. To enable
these labels for use in Logic, go to Options | Audio | I/O Labels.
8. The second column in the pop-up window will be named
“Provided by Driver.” Activate each of these labels for your
StudioLive. When you are done, close this window.
9. You are now ready to use your StudioLive.
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Avid Pro Tools 9+
1. Launch Pro Tools.
2. Got to Setup | Hardware and select PreSonus StudioLive
ARc from the Peripherals list. Click OK.
3. Go to Setup | Playback Engine and select PreSonus FireStudio
from the menu at the top of the window. Click OK.
Cakewalk Sonar 6+
1. Launch Sonar.
2. Go to Options | Audio... and click on the Advanced tab.
3. Change the Driver Mode to “ASIO.”
4. Click the “OK” button.
5. Restart Sonar.
6. Go to Options | Audio... and click on the Drivers tab.
7. Highlight all input and output drivers beginning with “PreSonus StudioLive ARc.”
8. Go to Options | Audio... and click on the General tab.
9. Set the Playback Timing Master to “PreSonus StudioLive ARc ... DAW Out 1.”
10. Set the Recording Timing Master to “PreSonus StudioLive ARc ... Mic/Inst 1.”

5.4

Digital Sends and Returns
When using the StudioLive as an audio interface, it is important to
understand the terms “digital send” and “digital return.” Because the
audio interface in the StudioLive is completely integrated with the other
functions of the mixer, the USB I/O is designed to work as an independent
bus. You can route (send) signals from other buses to the USB bus, and its
output (return) signal is hard-coded to designated mixer channels.
The StudioLive AR8c has 8 available sends and 4 returns.
The StudioLive AR12c has 14 available sends and 4 returns.
The StudioLive AR16c has 18 available sends and 4 returns.

5.4.1 Digital Sends
Each Mono and Stereo channel on the StudioLive ARc-series mixer has its own
digital send. This allows you to record every channel input on its own track in
Capture, Studio One Artist, or your favorite Core Audio and ASIO audio application.
The Main bus also features its own digital send on the final pair of
digital sends (AR8c: 7/8, AR12c: 13/14, and AR16c: 17/18).
Note: In Windows, these sends are the second to the last pair. The last pair of driver
inputs are reserved for loopback functionality. See Section 5.1.2 for more information.
The Main bus can also be recorded on the first two digital sends by engaging the USB
send 1/2 button on your StudioLive ARc-series mixer. When this
button is engaged, Channels 1 and 2 cannot be recorded
independently, but they will be recorded as part of the Main Mix.
This is a great option for recording rehearsals and podcasts.
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5.4.2 Digital Returns
The last two stereo channels on the StudioLive ARc mixers are hard-coded
to receive two stereo digital returns.
Digital returns 1/2 are available on the
Super Channel, Digital returns 3/4 are
routed to the last stereo channel
(AR8c: 7/8, AR12c: 13/14, and AR16c:
17/18). Outputs 1 through 4 in your
recording application route these
playback streams to these channels
on the StudioLive (that is, the
software’s Outputs 1/2 always go to
StudioLive ARc Super Channel and Output 3/4 always go to the last stereo
channel). Once you route a track in your recording application to play
through one of these outputs, it will always be accessible on its channel by
simply pressing the Digital Return button.
Power User Tip: It is important to think of your digital returns and your analog inputs in
the same way. When a digital return is engaged, it replaces the analog input in the mix.
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Capture 2

PreSonus® Capture™ 2.0 is a multitrack digital-audio recording application designed
to make recording with StudioLive™ mixers quick and easy. With the look and feel of
a digital multitrack hard-disk recorder, it is instantly familiar. It uses the same highquality audio engine as PreSonus’ groundbreaking Studio One® DAW, and its Session
files can be opened directly in Studio One—no conversion or exporting required.
Capture 2 was designed exclusively for StudioLive-series mixers,
allowing instant setup and recording directly from the mixer, with
no configuration. Just launch Capture 2 and click Record Now. At
the end of the show, click Stop, save the file, and you’re done!

6.1

Installation Instructions

6.1.1 macOS
Installing Capture 2 on macOS machines is as simple as drag-and-drop.
1.

Double-click on the Capture .dmg file.

2.

Drag the Capture 2 icon to the Applications folder shortcut.
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Once Capture has been copied to your hard drive, it is ready to use. Simply
open your Application folder and double-click on the Capture 2 icon.

6.1.2 Windows
The Windows installer for Capture 2 was designed with easy-to-follow
onscreen instructions to make the installation process quick and simple.
1. When you launch the Capture.exe file, a Welcome Screen will launch. If you haven’t
already done so, close all other open applications before clicking “Next.”

2. Before Capture 2 can be installed on your computer, you must first agree to the
licensing terms. Click “I agree.”

3. By default, Capture 2 will install in the Program Files folder on your computer. It is
highly recommended that you do not change this default location. Click “Install.”

4. Once Capture 2 has been successfully installed on your computer, you can click
“Finish” to exit the install wizard. You’re ready to start recording!
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Start Page
You will be taken to the Start page when Capture 2 is launched. The Start page allows
you to create a new Session, open a Session stored on your computer, view recent
Sessions, and verify that your StudioLive is properly communicating with its driver. In
addition, you can begin recording instantly by just clicking the Record Now button.

6.2.1 Tagging and Organizing a Session
At the top of the Start page, you will find the three Name Scheme
fields: Artist, Performance, and Location. By entering information into
each of these fields, your Session will be automatically named with this
information, in this order, and tagged with the same helpful metadata.
These tags also help to keep your files organized. Rather than throwing
every Session into a single folder, all tagged Sessions will automatically
be put into an organized folder hierarchy. By default, Capture 2 inserts
the date of performance and creates subfolders. These options can
be changed in the Options menu, see Section 6.2.5 for details.
By default, the folder tree is Artist/Performance/Location. This
structure is useful for regularly gigging bands that want to archive
performances (e.g., Artist: PreSonus All Stars, Performance: Winter Tour
2017, Location: Baton Rouge – Manship Theatre). However, Capture
2 doesn’t limit you to this folder structure. You can change the folder
hierarchy from the Options menu. Here are other available Name Schemes:
• Location/Artist/Performance. This Name Scheme is especially useful
for venue owners who are archiving the performances on their stage
(e.g., Location: Manship Theatre/PreSonus All Stars/Winter Tour 2017.
• Location/Performance/Artist. Use this Name Scheme when recording
an entire festival (e.g., PreSonuSphere/Stage 1/PreSonus All Stars).
As you archive your performances, Capture 2 stores a history of the names you have
entered into each field. To use a name again, simply click on the pull-down menu for
that field and select it from the list.

To clear the currently selected name from the list, select Remove First from the
pull-down menu.

To remove every name in the list, select Clear History. Once the history has been
cleared, it cannot be undone, so be certain before you choose this option.
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6.2.2 Creating a Session
Below the Name Scheme fields, you will find the New Session button. Click on the
New Session button to create an empty Session.
Power User Tip: A Session is a Capture 2 file in which you record, arrange,
and edit your audio files. Session files should not be confused with audio
files. Think of a Capture 2 Session as you would a StudioLive scene. It is a
snapshot of which audio files were recorded and how they were edited.
You can also create a new Session by doing one of the following:
•

Navigate to File/New Session.

• Press [Ctrl]/[Cmd]+N on the keyboard.
If you have filled in the Name Scheme fields, your
new Session will launch automatically.

If you have not filled in these fields, a setup menu will open.

• Session Title. This will be the title of your Session and will be the Session filename,
as well as the name of the new folder that contains all data related to your Session.
• Session Folder. This is where new Sessions and all related data will be saved.
The Session location can be chosen each time you create a Session. By default,
the new Session location will be the Capture 2 folder in your Documents folder.
You can choose a different file location by clicking on the Browse button and
browsing to a new location. The last known save location will appear as the default
the next time you create a new Session.
Power User Tip: The Name Scheme fields have been added to Capture 2
to help keep your Sessions organized and to make your archived library
of live performances more easily searchable. Because of this, we highly
recommend that you always take a moment to fill in these fields.
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Record Now! Clicking the Record Now button on the Start page will launch a new
Session, arm all tracks for recording, and begin recording immediately. If you do not
have any of the Name Scheme fields customized, your Session will be labeled with
today’s date.

6.2.3 Open a Session
The Capture 2 Start page provides two different
ways to quickly open previous Sessions.
Open Session Button
Clicking on the Open Session button will open a browser that will allow you to
browse for, and open, an existing Session.

Recent Files List
Located below the Open Session button, you will find the Recent
Files list. This list includes links to the most recently opened
documents. Click on any of these links to quickly open the
Session.

Locate Missing Files
In the event that the Session you open is missing audio files, Capture
will help you find them. Use Session>Locate Missing Files to search your
computer for lost resources.

6.2.4 Audio Device and Sample Rate
Capture 2 was created for use with PreSonus StudioLive-series mixers and
fully functions only with that device. The Audio Device menu displays the
currently selected audio driver. When a StudioLive ARc Mixer is connected, you
should select “StudioLive AR16c/AR12c/AR8c” from the Audio Device list.

If the currently selected audio device has exactly two outputs (as with the builtin audio card in a Mac), Capture goes into Stereo mode. While in Stereo mode,
Capture connects all tracks to the stereo output and adjusts the volume of the
output automatically to account for stereo summing. Stereo mode enables you
to listen to Sessions while away from your StudioLive. Unless the StudioLive’s
driver is selected, you cannot create a new Session or record new audio.
The Sample Rate menu displays the currently configured sample rate.
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6.2.5 Options Menu
The Options button can be found just above the bottom of the Start page. This
launches the Options menu.

This menu can also be accessed from Capture>Options.

It can also be accessed by clicking on the Options button on the Session page.

The Options menu provides all the tools necessary
to configure your Session preferences.
Audio Options

• Audio Device. At the top of the Audio Options, you will find
the Audio Device menu. This is the same menu that is on
the Start page. See Section 6.2.4 for information.
• Device Block Size. This displays the buffer size. In general, the higher the
buffer size is set, the more stable your recording environment will be.
• Sample Rate. The Sample Rate menu is also found on the
Start page. See Section 6.2.4 for information.
• Record Format. The Record Format menu allows you to
choose the bit-depth of the recorded audio. You can select 16bit WAV, 24-bit WAV, or 32-bit floating-point WAV.
Power User Tip: The higher the bit-depth of your audio, the better its resolution, and
the bigger the resulting file size will be. In general, we recommend recording at 24-bit.
• Pre-Record. Capture 2 allows you to set a Pre-Record buffer. This
buffer starts recording audio before your click the Record button so
you won’t miss the beginning of a performance. The Pre-Record buffer
time is user-selectable, between five seconds and one minute.
Power User Tip: The higher the Pre-Record buffer is set, the more RAM Capture 2 will
require. While this will not cause problems on modern systems that are equipped with
copious amounts of RAM, it is highly recommended that the Pre-Record buffer be set
as low as possible on systems with the minimum amount of required RAM (2 GB).
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Timeline Sync Options

• Timeline Sync Mode. Capture 2 features a Timeline Sync mode. This
allows you to align the timeline in your recording Session to the time of
day or to sync it to an external MIDI Time Code signal. This will also affect
the timestamp information, which is written into the audio files.
• No sync. The timeline will start at 0 and will display the length of
your recording (in minutes and seconds only). This option is useful
when you only want to track the length of your recording.
• Sync to computer time. The timeline ruler will start at the exact time of
day the recording began. This option is useful when recording multiple
performances over the course of a day (e.g., at a festival stage).
• Sync to MTC. Capture will align the timeline to incoming MIDI Time
Code. This option is useful when recording audio for a live video.
• MIDI Time Code Input. To use the Sync to MTC option, you must provide Capture
with an input for the source time code. You can select that source from this menu.
File Handling Options

As discussed in Section 6.2.1, Capture 2 provides an assortment
of useful tools to organize and label Capture Sessions.
• Storage Location. By default, all Capture Sessions are stored in the
Capture subfolder in your Documents folder. You can set a new default
location by clicking on the “Change…” link. This will launch a browser
window, allowing you to find a new location for your Capture Sessions.
• Name Scheme. Section 6.2.1 discusses the various options
for naming and organizing your files. This option enables you
to select the order in which your files are categorized.
• Create Subfolders. Clicking the Create Subfolders options will
create a folder for each of the three naming conventions: Artist,
Performance, and Location. If this box is not checked, your Session
and the resulting audio files will still be labeled using these tags but a
folder hierarchy will not be created. This box is enabled by default.
• Add Date to Path. By default, Capture automatically adds the date of the Session
to the Session name. You can remove the date by unchecking this option.
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The Session Page
Capture 2 features a single-window user interface so you don’t need to
manage multiple windows and views. When a new Session is created, or an
existing Session is opened, you will be taken to the Session page. This page
contains all of the necessary tools to record and edit multitrack audio.
When you launch Capture 2, a recording track is created for each input
channel on your StudioLive ARc mixer, including the Main bus. The Main
bus track, in turn, is automatically patched to the first two digital returns
located on the Super Channel on your StudioLive ARc mixer for playback.
Channels 1 and 2 are routed to the Digital Returns 3/4 on the last stereo
channel. The following diagrams show these configurations.

Capture 2 Recording Routing

Capture 2 Playback Routing

There is no need to set up audio inputs and outputs in Capture 2, as the
software automatically detects which StudioLive model is connected
and auto-configures for it. Each channel from the StudioLive ARc mixer
is represented with a mono input track in the Track column of the
Session and has a corresponding level meter in the meter bridge.
An additional stereo track will also be added to the
Session for recording the main mix.
Power User Tip: Unlike a DAW application, like Studio One Artist, Capture has
no mix engine of its own, relying, instead, on the physical mixer connected to
it to do the mixing and the summing. Because of this, once you’re ready to mix
your recordings, you will need to move you audio over to your favorite DAW
application. If your favorite DAW is Studio One, you can simply open your Capture
session from the Studio One Start page. See Section 6.6.2 for details.
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6.3.1 Track Column
Along the left side of the Session page, you will find the Track column. The Track
column contains a dedicated audio track for each audio input into Capture 2 from the
StudioLive ARc mixer, plus a stereo audio track to record the main mix.

Track Naming.
To name a track, double-click on the default name to open a textedit box. Enter the name you would like to use and hit Enter.
There are several benefits to giving each track in your Session a name. First,
it allows you to know at a glance what is being recording where. Second, if
you name your tracks before you begin recording, the audio file recorded
on your named track will be given the same name. So, for example, instead
of a bass line being recorded as Track 15, it would be recorded as Bass.
Power User Tip: As with Studio One, you can press the Tab
key to move to the next track’s name field.
Arm All.
In the upper left-hand corner, you will find the Arm All button. Click this button to
arm (enable) all inputs for recording.
Track Controls.
Each track in the Track column features the same controls.
Record Arm Button. Next to each track number is the Record Arm button. When
this button is active, Capture 2 is ready to record audio that is routed to the track.
Power User Tip: The track number to the left of each track in the list corresponds
directly to the same channel number on your StudioLive ARc mixer.
Track Mute. Each track features a Mute button. This mutes the track during playback.
Track Solo. Each track features a Solo button. This will solo the track and mute
all other tracks during playback (similar to the SIP function on the StudioLive).

6.3.2 Transport
The Transport is located in the top left corner of the
Session page. It contains all the functions you need to
navigate through your Session.

Stop. Stops playback.

Play. Starts playback at the current playback-cursor position.

Record. Starts recording at the current playback-cursor position.
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Session Lock. The Record Lock button prevents the recording from accidentally
being stopped by an errant press of the space bar. Session Lock is automatically
enabled when Capture starts recording. It can be defeated by simply clicking on it.
Power User Tip: Markers can still be edited and dropped while Session Lock is enabled.
Return to Zero. Returns the playback cursor to the beginning of the Session.
Previous Marker. Jumps the playback cursor to the previous marker.
Rewind. Rewinds as long as this button is enabled.
Fast Forward. Fast-forwards as long as this button is enabled.
Next Marker. Jumps the playback cursor to the next marker.
Go To End. Jumps the playback cursor to the end of the recorded audio.
Loop. Engages/disengages Loop mode. See Section 6.3.6.6 for more information.

6.3.3 Time Display

The Time Display provides you with critical information about your recording.
Session Name. Displays the name of the current Session.
Record Duration. Displays how long the current Session has been recording.
Cursor Time. Displays the current timeline position of the playback cursor.
Remaining Time. Displays the remaining time that can be recorded, based on the
size of the available storage left on the hard drive to which you are recording.

6.3.4 Timeline Ruler

At the top of the Session Editor, you will find the Timeline
Ruler. This displays time increments in seconds.
As mentioned in Section 6.2.5, you can set the Timeline Ruler to sync to
your computer’s clock or to an external MIDI Time Code source.

6.3.5 Navigating the Session
Zooming
You can zoom in and out of your Session, with respect to time, in the Session
Edit window, so that you can look at the entire length of the Session or
just view a small region of time to make accurate edits. You can also zoom
in and out with respect to the size of the audio files in your Session.
To zoom, do one of the following:
• To zoom in or out, click-and-drag left or right on the Horizontal Zoom scroll bar in
the lower right-hand corner of the Edit window.
• Press [Ctrl]/[Cmd]+[+] on the keyboard to zoom in slightly. Press
[Ctrl]/[Cmd]+[-] on the keyboard to zoom out slightly.
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• Click inside the Timeline Ruler at any point in time
and drag down or up to zoom in or out.

• In the lower left-hand corner of the Edit window, you will find the vertical-zoom
controls. These controls increase or decrease the height of the tracks and
audio files.

Scrolling

To scroll left and right through time in your Session, click-and-drag
the horizontal scroll bar near the bottom of the Edit window.
You can also scroll through your Session by clicking and
dragging the Timeline Ruler left or right.
Locate Selection

To jump the playback cursor to the beginning of any audio event,
press L on the keyboard or select Session>Locate Selection.

6.3.6 Editing Tools

In the upper right corner, you will see four editing-tool buttons. These
tools will determine the function of your mouse during editing.
Power User Tip: The audio-editing process can be unforgiving. Small inaccuracies when
splitting, moving, or performing other actions on recorded audio can lead to unwanted
results. As simple as it may seem, the act of listening while editing is often overlooked.
For instance, when sizing the edges of a vocal part to remove unwanted sounds
between words, it is tempting to make the edits based on the visual representation of
the waveform. While this may work sometimes, it is much better to listen as you size
the events to be sure you are not removing any critical part of the vocals. Listening
to your edits as you make them will save time and frustration in nearly every case.
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6.3.6.1 Arrow Tool
This is the default tool for access to most functions. Click on the Arrow tool button or
press [number 1] on the keyboard to select the Arrow tool.
The Arrow tool can be used for the following purposes:
Move an Event.
To move an audio event using the Arrow tool, click anywhere on the event and
drag left, right, up, or down. Dragging the event left or right will move the event
backward or forward in time. When dragging an event left or right beyond the
viewable arrangement, hold [Space Bar] on the keyboard to speed up the scrolling.

Dragging the event up or down will move the event to another track.
When dragging an event from one track to another (up or down), the
position of the event will be constrained within an automatic snapping
range to make it easy to keep the event at the same time position. To
defeat this snapping, hold Shift while dragging the event up or down.

Rearrange Tracks.
To rearrange tracks using the Arrow tool, click on the track you want to move and
drag up or down in the Tracks list. You will notice a blue line following your mouse.
When you drop the track, it will be inserted where the blue line is located.
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Size an Event.
Events can be thought of as windows into audio files and musical performances,
where what you see is what you hear. You can resize events to make them shorter
or longer so that only a portion of the audio or musical data is seen and heard.
To size any event using the Arrow tool, float the mouse to the left or right edge of the
event to reveal the Sizing tool. When this tool appears, click-and-drag left or right to
size the event. Events can be sized and resized nondestructively any number of times.

Select Multiple Events.
Multiple events can be selected in order to edit them all at once, with a single
action. To select multiple events with the Arrow tool, do one of the following:
• Click outside of the range of an event and then drag over any other
events; a gray box will be drawn while you drag over the target-selection
area. Release the mouse button once the box is drawn over all of the
events you wish to edit, and these events will be selected for editing.

• Click on any event; then, while holding [Shift] on the keyboard, click on any other
events to select them. This allows you to select multiple events that are not in
close proximity to each other. All selected events can then be edited at once.

6.3.6.2 Range Tool
The Range tool is used to select a range, or area, within events. Click on the Range
tool button or press [number 2] on the keyboard to select the Range tool.

To select a range within an event, using the Range tool, click-and-drag over the area
to be selected; a gray box will be drawn over the target selection area.
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Release the mouse button when the box is drawn over the
range of the events you wish to select. The range you have
selected is now treated as a single, consolidated event.
The Range tool can be useful in several ways:

• You can use the Range tool to select the content of several audio events
across multiple tracks for a specific portion of a song (say, an amazing
drum groove) and then use the Arrow tool to move that section of
audio to another section of a song (say, to replace a drum groove).
• Another common use of the Range tool is to quickly select and delete a
range of audio within an event, rather than using the Split tool to make
two splits, then select and delete the section with the Arrow tool.
Power User Tip: When you float the mouse cursor over a selected range, the Arrow tool
will temporarily appear. This makes it easy to quickly select and edit a range of events.
To select multiple, discontiguous ranges across any event, on any track, hold the
[Shift] key while using the Range tool. Continue to hold [Shift] and use the Arrow
tool to select whole events. For instance, when using the Arrow tool, if you press
and hold [Ctrl], you get the Range tool. Press and hold [Ctrl] and [Shift] to select
multiple ranges, then continue to hold [Shift] but release [Ctrl]; now you have the
Arrow tool and can select whole events. All of your selections will remain selected.
Selected ranges can be sized by floating the Range tool at the left/
right edge of the selection. You also can split a selected range at the left
and right edges of the selection by choosing Split Range from the Edit
menu or by pressing [Ctrl]/[Cmd]+[Alt]+[X] after selecting a range.

6.3.6.3 Split Tool
Using the Split tool, single events can be split into multiple events. Click on the Split
Tool button or press [number 3] on the keyboard to select the Split tool.
With the Split tool selected, a vertical and horizontal line will be drawn near the
current mouse-cursor position. The vertical line indicates the exact time position
of the Split tool, while the horizontal line underscores the track on which the event
to be split resides. The Split tool is directly affected by the current Snap settings.
Click on any event with the Split tool to split the event at that position.
By splitting a single event, you create two events that can be edited
independently. If multiple events are selected across multiple tracks,
the Split tool will affect all of the selected events in the same way.
It is also possible to split selected events at the timeline cursor, without
using the Split tool, by pressing [Alt]+[X] on the keyboard.

6.3.6.4 Eraser Tool
The Eraser tool is used to delete an event. Click on the Eraser Tool button or press
[number 4] on the keyboard to select the Eraser tool. To delete any event using the
Eraser tool, simply click on the event. The Eraser tool is unaffected by the current
selection and will only affect the event that is directly clicked on.
However, if you click on a selected element with the Eraser
tool, all currently selected elements will be erased.

6.3.6.5 Common Editing Actions
Like most software applications, Capture 2 supports basic cut,
copy, and paste actions. Once you’ve selected an event, or a range
of events, you can perform these actions as follows:
• Cut: Press [Ctrl]/[Cmd]+X on the keyboard to cut
the current selection or select Edit>Cut.
• Copy: Press [Ctrl]/[Cmd]+C on the keyboard to copy
the current selection or select Edit>Copy.
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• Paste: Once a selection is cut or copied, press [Ctrl]/[Cmd]+V on the keyboard
to paste the selection or select Edit>Paste. The selection will be pasted to the
current playback-cursor position, or to the beginning of the track from which
the selection originated if the playback cursor is not currently set anywhere.

6.3.6.6 Looping
To loop the playback of any range of your Capture 2 Session, do one of the following:
• Loop Selection. Select an event with the Arrow tool or select a range with
the Range tool. Go to Session>Loop Selection or press P on your keyboard.
This will create a loop the exact length of the selected audio event. The range
will be indicated by a bar drawn in the timeline, with flags at both ends.

• Custom Loop Range. To create a custom loop range, mouse over
the gray line above the timeline ruler. Notice that your cursor
changes to a Pencil tool, and you can draw your loop range.

Once your loop range is set, you can click on the Loop button in the transport, or
press [L] or [/] on the keyboard, to engage Loop mode.
Please Note: Engaging Record in the transport will disable Loop
mode and will begin recording at the current playback-cursor
position. It is not possible to engage Loop while recording.

6.3.6.7 Bounce Selection
Once you have edited an audio file, you may wish to create a new audio file
that includes all of your edits. To do this, use the Range tool to select the
events you would like to merge as described in Section 6.3.6.2 and press
[Ctrl]/[Cmd]+[B] on the keyboard or go to Edit>Bounce Selection.
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6.3.7 Meter Bridge
Capture 2 provides input and output metering
when a track is being recorded or played back.
These peak-style meters at the bottom of the
Session page feature clip indicators for each input
into Capture 2 from the StudioLive ARc-series mixer.
Record Arm.
Below each meter, you will find another Record Arm button. This button provides the
same functionality as the Record Arm button in the Track column. See Section 6.3.1
for more information.
Link Button.
Between each meter you will find a Link button. When this button is active, Capture 2
will record that track as a stereo-interleaved file. By default, the mix mix track is stereo
linked.
Big Meter Mode.

The Big Meter Mode button is located in the upper right
corner of the Session page, above the editing tools.

When this button is engaged, the lower three-quarters of the Session page
will display detailed metering for every track. While in this mode, the Marker
Lane, transport, mode buttons, and editing tools will still be visible.

6.3.8 Markers and the Marker List
The Marker Lane.

The Marker Lane is located just below the Timeline Ruler.
It displays any markers you have created.
In Capture 2, the Marker Lane is used to place markers at desired
places in the timeline, after which navigation to the markers is easy.
Markers are also helpful when exporting your Session to individual
mixes or for editing in another recording application.
Power User Tip: We highly recommend that markers be inserted during the recording of a
live performance, as the markers will make the rest of the production process much easier.
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The Marker List.

The Marker List button is located above the editing tools on the right side
of the Session page. Clicking on the button will open the Marker List, which
provides an overview of every marker in your Session and offers an easier
way to quickly name markers and move them around your Session.

6.3.8.1 Inserting, Naming, Deleting, and Moving Markers
Marker Lane.
Adding/Deleting Markers. At the top of the Track column, you will see the Add/
Remove Marker buttons. To insert a new marker into the Marker Lane, with playback
running or stopped, click on the Add Marker (+) button, or press [Insert] on the
keyboard. Each new marker will be numbered sequentially by default (#1, #2, #3….).
Select a marker and click on the Remove Marker (-) button to remove the marker.
Naming Markers. To rename a marker, double-click on the marker in the Marker
Lane, type in a new name, and then press [Enter] on the keyboard.

Moving Markers. To move a marker, click on it in the
Marker Lane and drag it to the desired location.

Marker List.
At the bottom of the Marker List, you will find three buttons.

Adding Markers. Click on Add Marker to add a marker
at the current playback-cursor position.

When a Marker is added to the Marker List, the Name field
automatically becomes editable. Enter a new name and hit Enter.
This name can be edited later by double-clicking on it.
Moving Markers. Clicking on the Move Marker button will move the currently
selected marker in the Marker List to the current playback position in the timeline.
Deleting Markers. To remove a marker, select it in the
Marker List and click on the Delete Marker button.
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6.3.8.2 Navigating Markers
It is possible to quickly jump the playback cursor between markers in
the Marker Lane. Jumping to markers during playback allows quick
comparisons between different sections of your Session.
To navigate to a previous marker, do one of the following:
• Click on the Previous Marker button in the transport.
• Press [B] on the keyboard, to jump to the previous marker.
To navigate to the next marker, do one of the following:
• Click on the Next Marker button in the transport.
• Press [N] on the keyboard, to jump to the next marker.
To jump to any marker in your Session, open the Marker List and click on the
Location field. The playback cursor will jump to this location in the timeline.

6.4

Recording a Session in Capture
Setting Input Levels. Setting the proper input level is critical to making a good live
mix and a good recording. The basic idea is to set the input gain on the StudioLive
ARc-series mixer as high as possible without overloading the input. Overloading
the input will cause clipping (digital distortion), which is particularly unpleasant
and will ruin the recording. This damage cannot be undone in software. There
is a clip indicator for each input on the StudioLive ARc mixer for this purpose.
If an input channel is not clipping on your StudioLive ARc-series mixer, you can
be sure that it will not clip in Capture 2. Refer to Section 2.1 for the proper
level-setting procedure.
You will monitor live audio input on the StudioLive ARc-series mixer; there is no
separate monitoring capability within Capture 2. Please refer to Section 3.4.2 for
information on creating monitor mixes.
Arming Tracks. To record to an audio track, the track must be recordenabled, or “armed.” Capture 2 provides two Record Enable buttons for
each input: one on the track and on the meter bridge. Once an audio
track is record enabled, you are ready to record audio to that track.
Hit Record! To activate recording, click on the Record button in the transport. The
Record button will turn red, and the Play button will turn green. The playback cursor
will start to scroll from left to right from its current position, and new audio events
will be recorded to record-enabled tracks.
Recording will continue until you manually stop it by clicking on the Stop button in
the Transport or by pressing [Spacebar] on the keyboard.
When you press Record, the Session automatically locks. This prevents you from
accidentally stopping recording Session. You must disable Session Lock before you
can stop recording.
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Importing and Exporting Audio Files

6.5.1 Importing Audio Files into Capture
It is possible to import WAV and AIFF audio files into your Session.
1. To import an audio file, select Import Audio File from the Session menu,
or [Ctrl]/[Cmd]+I on the keyboard, to open the Import File menu.

2. Browse to the desired file and click on it to select it.

3. Click on Open to import the file into your Session.
4. An audio event for the imported file will be created and placed on the currently
selected track in your Session, at the current playback-cursor position.
Power User Tip: When browsing for files in the Import File menu, it is possible to listen
to the audio files as you are browsing in the Preview Player. Click the Play button in the
Preview Player to play the currently selected audio file. Click the Stop button to stop
playback. Click the Loop button to loop the playback of the currently selected audio file.
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6.5.2 Export Audio Files
To export audio from your Session in Capture 2, navigate to Session/Export Tracks,
or press [Ctrl]/[Cmd]+E on the keyboard to open the Export to Tracks menu.

Location.
In the top section of the Export Tracks menu, select
a location and name for the audio file.

Click on the Browse button to choose a file location.
Double-click on the filename, type in a new name, and then press Enter to
choose a name for the file. Each file that is exported will begin with the filename
you enter, followed by the name of the track from which it was exported
and the first marker of the marker pair (if applicable). Examples: “French
Quarter Fest 2012 – Kick” or “French Quarter Fest 2012 – Kick – Chorus.”
Format.
In the middle section of the Export Tracks menu, select the
format of the mixdown audio file. Choose from WAV or AIFF, and
then choose the desired resolution and sample rate.

If you wish to put your audio on a standard audio CD, the format should
be a WAV file with 16-bit resolution and a 44.1 kHz sample rate.
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Options.
The bottom section of the Export Tracks menu has several
options that will affect how files are created:

• Export Session will export the entire range of your Session to the
furthest point in time that any audio event on a track extends.
• Export Between Each Marker will export separate files for
each range between the markers in the Marker Lane.
• Export Between Selected Markers will export audio files between
the ranges of any two selected markers in the Marker Lane.

6.6

Mixing Your Capture Sessions

6.6.1 Exporting Your Final Mix to an Audio File
The most common physical medium on which recordings are published
is the audio CD. In order to put your final mix on an audio CD, the mix file
must be a 16-bit, 44.1 kHz WAV file. Once you have recorded your final mix
to the Auxiliary Stereo track in Capture 2, it is recommended you export
the audio from the Auxiliary Stereo track to an audio file for this purpose.
See Section 6.5.2 for details on Exporting Audio Tracks in Capture 2.
Once the correct audio file for your mix has been exported, you
may use any CD-burning application (including PreSonus Studio
One Professional) to put that mix on a recordable audio CD.

6.6.2 Mixing a Capture 2 Session in Studio One
Many users want to use Capture 2 strictly as a track-recording tool and will
mix and sweeten the recorded tracks later in a DAW. PreSonus has included a
copy of Studio One Artist with your StudioLive for this purpose. All versions of
Studio One can open Capture 2 Session files. All markers, edits, track names,
etc., will be preserved, and no further effort is required. Simply launch Studio
One and open your Capture 2 Session. See Section 7 for more details.

6.6.3 Mixing a Capture 2 Session in a Different Recording Application
For users who wish to mix their Capture 2 Session in a DAW other than Studio
One, there are several ways in which to import your Capture 2 Session.
Save a Capture 2 Session as OpenTL
Many audio-recording programs can open OpenTL (Open Track List) files. An OpenTL
file provides a reference for all of the audio tracks and audio events, with their
corresponding positions, in a Capture 2 Session, so that another audio program can
reconstruct your Session automatically. This makes it possible for you to open your
Capture 2 Session and work as you normally do in your favorite recording application.
To save an OpenTL version of your Session, select Save
Session As in the File menu of Capture 2.
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Name the file as usual, and choose OpenTL (*.tl) in the Save As Type selection box.

Click on Save to save your Session as an OpenTL document and confirm the
command by clicking Yes in the confirmation window. This file will be placed
by default in your Session folder and will not overwrite the original Capture 2
Session file. Note that the OpenTL format will not save your markers.
Import Capture 2 Session Audio Files Directly
Some audio-editing applications (such as digital audio workstations, or DAWs)
do not support the OpenTL format, which makes the options somewhat limited
when importing Sessions created in other programs. In this case, you must
manually import the audio events from your Capture 2 Session into the audioediting application, using whatever means possible in that program. Refer to
the documentation of your software for more information on this process.
Note that in some cases, you may have more than one audio event on a given track,
as opposed to a single continuous audio event, or you may have audio events that
do not have the same start position. In either case, it is highly recommended that
you first export the audio for each track before attempting to import into an audioediting program, as described in the Export Audio Files portion of this section.
Be sure to select the Export Tracks option in the Export Audio
File menu, as shown, so that the result of the process will be a
single continuous audio file for each track in the Session.
Once you have single, continuous audio files for each track, directly importing
the files into an audio editor is much easier. All that is required to reconstruct
your Capture 2 Session is to align each file at the same start time. For complete
information on exporting tracks from Capture 2, please review Section 6.5.2.
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6.7

Capture 2 Key Commands
Action

Key Command

Action

File Menu
New Session

Key Command

Transport
Cntrl/Cmd+N

Toggle Start/Stop

Space Bar

Open Session

Cntrl/Cmd+O

Start

Enter

Close Session

Cntrl/Cmd+W

Record

NumPad *

Save Session

Cntrl/Cmd+S

Stop

NumPad 0

Save Session As

Cntrl/Cmd+Shift+S

Return to Zero

NumPad

Quit

Cntrl/Cmd+Q

Record Lock

Cntrl/Cmd+L

Undo

Cntrl/Cmd+Z

Focus Next

Tab

Redo

Cntrl/Cmd+Y

Focus Previous

Shift+Tab

Edit Menu

Navigation

Cut

Cntrl/Cmd+X

Left

Left Arrow

Copy

Cntrl/Cmd+C

Extend Selection Left

Shift+Left Arrow

Paste

Cntrl/Cmd+V

Extend Selection Left Add

Cntrl/Cmd+Shift+Left Arrow

Delete

Del

Skip Left

Cntrl/Cmd+Left Arrow

Select All

Cntrl/Cmd+A

Right

Right Arrow

Deselect All

Cntrl/Cmd+D

Extend Selection Right

Shift+Right Arrow

Bounce Selection

Cntrl/Cmd+B

Extend Selection Right Add

Cntrl/Cmd+Shift+Right Arrow

Zoom In

Cntrl/Cmd + or E

Skip Right

Cntrl/Cmd+Right Arrow

Zoom Out

Cntrl/Cmd - or W

Up

Up Arrow

Zoom Full

F

Extend Selection Up

Shift+Up Arrow

Session Menu

Extend Selection Up Add

Cntrl/Cmd+Shift+Up Arrow

Import File

Command+I

Skip Up

Cntrl/Cmd+Up Arrow

Export Tracks

Command+E

Down

Down Arrow

Toggle Start/Stop

Space Bar

Extend Selection Down

Shift+Down Arrow

Record

NumPad *

Extend Selection Down Add

Cntrl/Cmd+Shift+Down Arrow

Stop

0

Skip Down

Cntrl/Cmd+Down Arrow

Return to Zero

,

Page Up

Page Up

Go to End

E

Extend Selection Page Up

Shift+Page Up

Extend Selection Page Up
Add

Cntrl/Cmd+Shift+Page Up

Skip Page Up

Cntrl/Cmd+Page Up

Loop Active

/

Loop Selection

P

Locate Selection

L

Insert Marker

Ins, I

Insert Named Marker

Shift+Ins, Shift+I

Locate Next Marker

N

Locate Previous Marker

B

Enable Sound Check

F4
Tools

Select Arrow Tool

1

Select Range Tool

2

Select Split Tool

3

Select Eraser Tool

4
Views

Options

Cntrl/Cmd+[+]

Big Meters

F2

Marker List

F3

Enable Soundcheck

F4

Page Down

Page Down

Extend Selection Page Down

Shift+Page Down

Extend Selection Page Down
Add

Cntrl/Cmd+Shift+Page Down

Skip Page Down

Cntrl/Cmd+Page Down

Start

Home

Extend Selection Start

Shift+Home

Extend Selection Start Add

Cntrl/Cmd+Shift+Home

Skip Start

Cntrl/Cmd+Home

End

End

Extend Selection End

Shift+End

Extend Selection End Add

Cntrl/Cmd+Shift+End

Skip End

Cntrl/Cmd+End
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Studio One Artist Quick Start

All PreSonus professional recording products come with Studio One Artist
recording and production software. Whether you are about to record
your first album or your fiftieth, Studio One Artist provides you with all
of the tools necessary to capture and mix a great performance.
Power User Tip: As a valued PreSonus customer, you are eligible for a discount
upgrade to Studio One Professional. For more details on the Studio One upgrade
program for PreSonus customers, please visit http://studioone.presonus.com/.

7.1

Installation and Authorization
Once you have installed the drivers for your audio interface and connected it
to your computer, you can use the included PreSonus Studio One Artist musicproduction software to begin recording, mixing, and producing your music.
To install Studio One Artist, log into your My PreSonus account and register
your interface. Your product key for Studio One Artist will automatically be
registered to your My PreSonus account with your hardware registration.

Downloading and running the Studio One installer.
To install Studio One Artist, download the Studio One Artist installer from
your My PreSonus account to the computer on which you will use it.

50

7
7.2

Studio One Artist Quick Start
Setting Up Studio One

StudioLive™ ARc Series
Owner’s Manual

• Windows users: Launch the Studio One Artist installer
and follow the onscreen instructions.
• Mac users: Drag the Studio One Artist application into
the Applications folder on your Mac hard drive.
Authorizing Studio One
When Studio One is launched for the first time on your computer, it will
communicate with your My PreSonus account and verify your registration. To
ensure a seamless authorization process, make sure to download your installer
to the computer on which you will be using it and be sure that your computer is
connected to the Internet when you launch the application for the first time.
Installing bundled content for Studio One Artist.
Studio One Artist comes bundled with an array of demo and tutorial
materials, instruments, loops, and samples. The Studio One Artist
bundle includes all that you need to begin producing music.
The first time you launch Studio One Artist, you will be prompted
to install its companion content. Select the content you wish to
add and click “Install.” The content will automatically begin to
download and install from your My PreSonus user account.

Power User Tip: You may be prompted to enter your My PreSonus user account
information. Clicking “Remember Credentials” will allow you to have immediate
access to any content you purchase from the PreSonus Marketplace.

7.2

Setting Up Studio One
Studio One Artist was designed to work with PreSonus interfaces and provides
unique interoperability and simplified setup. When Studio One Artist is
launched, by default you will be taken to the Start page. On this page, you will
find document-management and device-configuration controls, as well as a
customizable artist profile, a news feed, and links to demos and tutorials from
PreSonus. If you have an Internet connection on your computer, these links will
be updated as new tutorials become available on the PreSonus Web site.
Complete information on all aspects of Studio One Artist is available in
the Reference Manual PDF located within Studio One. The information
in this tutorial covers only the basic aspects of Studio One Artist and is
intended to get you set up and recording as quickly as possible.

51

7
7.2

Studio One Artist Quick Start
Setting Up Studio One

StudioLive™ ARc Series
Owner’s Manual

7.2.1 Configuring Audio Devices
1. In the middle of the Start page, you will see the Setup area. Studio One
Artist automatically scans your system for all available drivers and selects
a driver. By default, it will choose a PreSonus driver if one is available.

2. If you do not see your device listed on the Start page when
you launch Studio One, click on the Configure Audio Devices
link in the Setup area to open the Options window.

In the Options window, click on the Audio Setup tab and
select your device driver from the pull-down.
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7.2.2 Configuring MIDI Devices
From the External Devices window in Studio One Artist, you can configure
your MIDI keyboard controller, sound modules, and control surfaces. This
section will guide you through setting up your MIDI keyboard controller
and sound modules. Please consult the Reference Manual located within
Studio One for complete setup instructions for other MIDI devices.
If you are using a third-party MIDI interface or USB MIDI-controller
keyboard, you must install any required drivers for these devices before
beginning this section. Please consult the documentation that came
with your MIDI hardware for complete installation instructions.
If you do not have any MIDI devices, please skip to Section 7.3.
Setting up an external MIDI keyboard controller from the Start page.
A MIDI keyboard controller is a hardware device that is generally used for playing
and controlling other MIDI devices, virtual instruments, and software parameters.
In Studio One Artist, these devices are referred to as Keyboards, and they must be
configured before they are available for use. In some cases, your MIDI keyboard
controller is also used as a tone generator. Studio One Artist views the controller
and tone-generation functions as two different devices; a MIDI keyboard controller
and a sound module. The MIDI controls (keyboard, knobs, faders, etc.) will be
set up as a Keyboard. The sound modules will be set up as an Instrument.
You can set up your external MIDI devices from the Setup area
in the Start page. Before setting up a new Song for recording,
take a moment to configure external devices.
Make sure you have connected the MIDI Out of your external MIDI controller to
a MIDI In on your PreSonus audio interface (if available) or other MIDI interface. If
you are using a USB MIDI controller, connect it to your computer and power it on.
1. Click on the Configure External Devices link in the Setup area on
the Start page to launch the External Devices window.
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2. Click the Add button. This will launch the Add Device window.

3. From the menu on the left, select your MIDI controller from the list of
manufacturers and models. If you do not see your MIDI controller listed,
select New Keyboard. At this point, you can customize the name of
your keyboard by entering the manufacturer and device names.

4. You must specify which MIDI channels will be used to communicate with
this keyboard. For most purposes, you should select all MIDI channels.
If you are unsure of which MIDI channels to choose, select all 16.
5. Studio One allows you to filter out specific control functions. If you would
like Studio One to ignore Aftertouch, Pitch Bend, Program Change, or
All CC messages, enable filtering for any or all of these messages.
6. In the Receive From drop-down menu, select the MIDI interface
input from which Studio One Artist will receive MIDI data (that
is, the MIDI port to which your keyboard is connected).
Power User Tip: In the Send To drop-down menu, select the MIDI
interface output from which your Studio One Artist will send MIDI data
to your keyboard. If your keyboard controller doesn’t need to receive
MIDI data from Studio One, you can leave this unselected.
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7. If this is the only keyboard that you will use to control your external
synthesizers and virtual instruments, you should check the box
next to Default Instrument Input. This will automatically assign your
keyboard to control all MIDI devices in Studio One Artist.
8. Click OK.
If you have a sound module that you’d like to connect, leave the External
Devices window open and proceed to the next part of this section.
If not, you can close the window and skip to the next section.
Setting up an external MIDI sound module from the Start page.
MIDI instrument controllers (keyboards, MIDI guitars, etc.) send musical information
in the form of MIDI data to tone modules and virtual instruments, which respond
by generating sound, as instructed. Tone modules can be standalone sound devices
or can be integrated into a MIDI instrument, such as a keyboard synthesizer. Studio
One Artist refers to all tone generators as Instruments. Once you have set up your
MIDI keyboard controller, take a moment to configure your sound module.
Make sure you have connected the MIDI In of your external
sound module to the MIDI Out of your MIDI interface.
1. In the External Devices window, click the Add button.
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2. Select your device in the menu on the left. If your device is not listed,
select New Instrument. At this point you can customize the name of
your keyboard by entering the manufacturer and device names.

3. Specify which MIDI channels will be used to communicate with this sound
module. For most purposes, you should select all MIDI channels. If you are
unsure of which MIDI channels to select, we suggest you select all 16.
4. In the Send To menu, select the MIDI interface output from which Studio One
Artist will send MIDI data to your sound module. Click OK and close the External
Devices window. You are now ready to start recording in Studio One Artist.
The rest of this Quick Start Guide will go over how to set
up a Song and will discuss some general workflow tips for
navigating through the Studio One Artist environment.

7.3

Creating a New Song
Now that you’ve configured your audio and MIDI devices, let’s create
a new Song. We’ll start by setting up your default audio I/O.
1. From the Start page, select Create a New Song.
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2. In the New Song window, name your Song and choose the directory in which
you’d like it saved. From the Interfaces tab, you can select custom templates for
your StudioLive ARc-series mixer that will set all configuration and I/O settings
for you. The rest of section will describe creating a Song from an empty session.

3. Select Empty Song from the Templates list. At this point, you should give
your Song a name and select your preferred sample rate and bit depth for
recording and playback. You can also set the length of your Song and the
type of time format you would like the timeline to follow (notation bars,
seconds, samples, or frames). Click the OK button when you are finished.
Power User Tip: If you plan to import loops into your Song, make
sure that the Stretch Audio Files to Song Tempo option is selected.
This will automatically import loops at the correct BPM.

7.3.1 Configuring Your I/O
1. Click on Song | Song Setup to set your sample rate and
resolution and configure your audio I/O.

2. Click on the Audio I/O Setup tab.
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3. From the Inputs tab, you can enable any or all of the inputs on your StudioLive ARc
mixer that you’d like to have available. We recommend that you create a mono
input for each of the inputs on your interface. If you plan on recording in stereo,
you should also create a few stereo inputs. You can give each input a custom name
by simply clicking on the default name. Press the TAB key to edit the next name.

4. Click on the Outputs tabs to enable any or all of the outputs on your StudioLive
ARc Mixer. In the lower right corner, you will see the Audition select menu.
This allows you to choose the output from which you will audition audio files
prior to importing them into Studio One Artist. In general, you will want this to
be the main output bus. You can give each output a custom name by simply
clicking on the default name. Press the TAB key to edit the next name.

Power User Tip: If you would like this I/O configuration to be the same
every time you open Studio One, click the Make Default button.
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7.3.2 Creating Audio and MIDI Tracks
1. In the upper left corner of the Arrange window, you will notice
several buttons. The button furthest to the right is the Add Tracks
button. Click on this button to open the Add Tracks window.

2. In the Add Tracks window, you can customize the track name and
color, add a preset rack of effects, and set the physical source for
the input and output of your audio tracks. Most important, you can
select the number and type of tracks you’d like to create.

• Audio. Use this track type to record and playback audio files.
• Instrument. Use this track to record and playback MIDI data to
control external MIDI devices or Virtual Instrument plug-ins.
• Automation. This track type lets you create automated
parameter controls for your session.
• Folder. This track helps you to manage your session as
well as to quickly edit multiple tracks at once.
Power User Tip: If you would like to add an audio track for each of the
available inputs, simply go to Track | Add Tracks for All Inputs.

Custom
Track
Color

Rec
Track
Mute Arm
Name
Solo Monitor

Meter

ST/Mono
Audio Input
Source Select

Note: MIDI tracks are nearly identical to Audio tracks. The Input
Source list for MIDI tracks lists available external MIDI devices as well
as any virtual instruments that have been added to the Song.
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7.3.3 Recording an Audio Track
1. To begin recording, create an audio track from the Add Tracks
window, set its input to Input 1 on your StudioLive ARc-series
mixer, and connect a microphone to the same input.

2. Select Record Enable on the track. Turn up the Input 1 level on your audio
interface while speaking/singing into the microphone. You should see
the input meter in Studio One Artist react to the input. Adjust the gain
so the input level is near its maximum without clipping (distorting).

You are now ready to start recording. For complete instructions, please consult the
Studio One Reference manual located in Help | Studio One Reference Manual.

7.3.4 Adding Virtual Instruments and Effects
You can add plug-ins and instruments to your Song by dragging-and-dropping
them from the browser. You can also drag an effect or group of effects from one
channel to another, drag in customized effects chains, and instantly load your
favorite virtual-instrument preset without ever scrolling through a menu.
Opening the browser.
In the lower right corner of the Arrange window are three buttons:

• The Edit button opens and closes the audio and MIDI editors.
• The Mix button opens and closes the Mixer window.
• The Browse button opens the browser, which displays all of the
available virtual instruments, plug-in effects, audio files, and MIDI files,
as well as the pool of audio files loaded into the current session.
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Drag-and-drop virtual instruments.
To add a virtual instrument to you session, open the browser and click on
the Instrument button. Select the instrument or one of its patches from the
instrument browser and drag it into the Arrange view. Studio One Artist will
automatically create a new track and load the instrument as the input.

Drag-and-drop effects.
To add a plug-in effect to a track, click the Effects button in the browser and
select the plug-in or one of its presets in the effects browser. Drag-and-drop
the selection over the track to which you would like to add the effect.

Drag-and-drop audio and MIDI files.
Audio and MIDI files can be quickly located, auditioned, and imported into
your Song by dragging them from the file browser into the Arrange view.
If you drag the file to an empty space, a new track will be created with
that file placed at the position to which you dragged it. If you drag the file
to an existing track, the file will be placed as a new part of the track.
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Table 1

Instrument

What to Cut

Why to Cut

What to Boost

Why to Boost

Human Voice

7 kHz

Sibilance

8 kHz

Big sound

2 kHz

Shrill

3 kHz and above

Clarity

1 kHz

Nasal

200-400 Hz

Body

80 Hz and below

Popping P’s

1-2 kHz

Tinny

5 kHz

More presence

300 Hz

Boomy

100 Hz

Bottom end

1-2 kHz

Shrill

3 kHz

Clarity

80 Hz and below

Muddy

125 Hz

Bottom end

2-3 kHz

Tinny

5 kHz and above

Sparkle

200 Hz

Boomy

125 Hz

Full

1 kHz

Thin

600 Hz

Growl

125 Hz

Boomy

80 Hz and below

Bottom end

600 Hz

Hollow

2-5 kHz

Sharp attack

200 Hz

Boomy

125 Hz and below

Bottom end

1 kHz

Annoying

2 kHz

Crisp

150-200 Hz

Full

80 Hz

Deep

Piano

Electric Guitar

Acoustic Guitar

Electric Bass

String Bass

Snare Drum

Kick Drum

Toms

Cymbals

Horns

String section

400 Hz

Muddy

2-5 kHz

Sharp attack

80 Hz and below

Boomy

60-125 Hz

Bottom end

300 Hz

Boomy

2-5 kHz

Sharp attack

80-200 Hz

Bottom end

7-8 kHz

Sizzle

8-12 kHz

Brilliance

15 kHz

Air

1 kHz

Annoying

1 kHz

Honky

8-12 kHz

Big sound

120 Hz and below

Muddy

2 kHz

Clarity

3 kHz

Shrill

2 kHz

Clarity

120 Hz and below

Muddy

400-600 Hz

Lush and full
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Table 2
•
•
•

BOOST

harder bass to low
frequency
instruments (kick,
tom, bass)
guitar and snare
fullness

•

piano and horns
warmth

bass line clarity
(especially for softer
playback levels)

•

•
•
•

bass line clarity
and punch

•
•
•

fullness to low
frequency
instruments
(kick, tom, bass)

•
•

50 Hz

100 Hz

•
•

•

decrease bass
“boom” to increase
clarity in the mix

vocal fullness

•

hard hitting snare
and guitar

200 Hz

•

increase guitar clarity
lessen guitar “boom”

•
•

400 Hz

decrease muddiness in
vocals and mid-range
instruments
decrease long bass
overtones in cymbals

bass line clarity
and punch

800 Hz

1.5 kHz

•

decrease kick and
tom dullness

vocal presence
kick & tom attack
more finger sound
on bass

•

piano and acoustic
guitar attack

•

brighter rock guitar

•
•
•
•
•

bass “pluck”
acoustic/electric
guitar attack

•

lower piano register
attack

•

vocal clarity

3 kHz

decrease dullness
in guitars

adds distance to
background
instruments

•

softens a “thin” guitar

•

decrease guitar
thinness

•

enhance background
vocal breathiness

•

lessen overly
bright guitar
overtones

•

disguise vocals and
guitars that are slightly
out of tune

brighten vocals,
acoustic guitar,
piano

•

harder cymbals

kick & tom attack
percussion attack
more finger sound on bass

•
•

sharpness to:
synths, rock guitars,
acoustic guitars, piano

•

reduce vocal dullness

5 kHz

•

•

7 kHz

10 kHz

•

•

breathier vocals
brighten cymbals,
string instruments,
flutes
more realistic
samples and synths

15 kHz

vocals: reduce
“s” sound

vocals: reduce
“s” sound

CUT
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8.2

Block Diagrams

8.2.1 StudioLive AR16c, and AR12c Block Diagram
Main L/R USB SEND

1/2

Channel 1/2 Send
Main L/R Send

USB Send 1&2

Input Channels 1 & 2 Gain
+12 to +55 dB
(StudioLive AR16c and AR12c) Mic
Instrument +12 to +55 dB
Line -5 to +35 dB

Mic Input

Main Mix L
Main Mix R
Solo Bus L
Solo Bus R
Aux 1
Aux 2
FX

Main L/R

ADC
Clip
(red)

Signal
(green)

Mic Pre

Low Cut
On/Off

Low Cut Out

+
-

80 Hz

Line/Instrument Input

Level

Equalizer

Low Cut In

140 - 3500 Hz

Main Mix L
Main Mix R

12 kHz

Pan

-15 to +15 dB -15 to +15 dB -15 to +15 dB

Main Meters

PFL

Solo

Channel Insert

Level

Aux 1

-120 - +10 dB

Aux 2

BALANCE LINE DRIVERS

+

Mic +12 to +55 dB
Line -5 to +35 dB

-

ADC

Gain

+

Mono Input Channels

AR12: USB Send 3-4
AR16: USB Send 3-8
AR22: USB Send 3-12

-

48V On

Main Right

+

Send Level

48V Off

-

48V

Level

Main Left

+

FX
Send Level

Left

Main Output
Right

USB Send

1/2

Clip
(red)

Signal
(green)

Master Bus USB Send (AR12: 13/14, AR16: 15/16)

ADC

Master Bus USB Send 1/2

Mic Input

Mic Pre

Low Cut
On/Off

Low Cut Out

Level

Equalizer

Low Cut In

+

Main Mix L
Main Mix R

80 Hz

140 - 3500 Hz

12 kHz

Pan

Master Bus Send to SD Recorder

PFL

-15 to +15 dB -15 to +15 dB -15 to +15 dB

Line Input

PFL
Level

Aux 1

-120 - +10 dB

Aux 2

AR12c: USB Send 5/6-11/12
AR16c: USB Send 9/10-15/16

+

Signal
(green)

Aux 1
-

(identical except
for USB Return on
last channel)

ADC
ADC

Mon 2

+

Mic +12 to +55

Mon 1
Send Level

Gain

Stereo Input Channels

Level

FX
Send Level

Clip
(red)

Aux 2

Aux Out 1
Aux Out 2

AFL

Mic Pre

[if Mono: Mains Splits to Left/Right. See Mono Channels]

(Last Stereo Channel Only)

AFL

+10 dB Boost Off
+10 dB Boost On

On/Off

Left (Mono)

Level

Equalizer

Main Mix L
Main Mix R

+10 dB
80 Hz

Right

2.5 kHz

12 kHz

-15 to +15 dB -15 to +15 dB -15 to +15 dB

Pan

PFL

PFL
PFL

USB Return 3/4

DAC

[if Mono: PFL send Splits to Left/Right. See Mono Channels]

Level

Aux1

-120 - +10 dB

Aux 2
FX

Cue Level
(PFL/AFL Master)

Send Level

If Left/Mono only is connected, signal is sent to both Left/Right on Main Bus and Solo Bus
If Right only is connected, signal is sent to the Right side only on the Main Bus or Solo Bus

Solo Bus L

Send Level

Solo Bus R
-120 - +10 dB

Global
(any solo)

Control Room Bus L

Control Room Out L
Control Room Out R

+

Main Mix L
Main Mix R

RCA RIGHT

BALANCE

Phones Output

-

Aux 1

-120 - +10 dB

Level

-120 - +10 dB

Aux 2
-

DAC

Phones Level
-

USB 1&2

USB / SD Toggle

PFL

PFL
PFL

+

SD 1&2

+

STEREO 1/8”

Send Level

+

SD Playback 1&2

Control Room L
Control Room R

+

-120 - +10 dB

Level

RCA Left

USB Return 1&2

Monitor Level

Control Room Bus R

Super Channel

-

PFL/AFL

FX Bus Send

DAC

FX Out

FX Out

FX Engine
Level

FX Bus Return L
FX Bus Return R

Bluetooth

BALANCE

Footswitch
(FX Mute)

Aux1
Aux 2

NOTE: All switches are shown in the default (up) position

Main Mix L
Main Mix R
Solo Bus L
Solo Bus R
Aux 1
Aux 2
FX

Send Level

StudioLive AR16c & AR12c
BLOCK DIAGRAM
™
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8.2.2 StudioLive AR8c Block Diagram
Main L/R USB SEND

1/2

Channel 1/2 Send
Main L/R Send

USB Send 1&2

Gain

Input Channels 1&2

Mic Input

Main Mix L
Main Mix R
Solo Bus L
Solo Bus R
Aux
FX

Main L/R

ADC

Mic +12 to +55 dB
Instrument +12 to +55 dB Signal
Line -5 to +35 dB
(green)

Clip
(red)

Mic Pre

Low Cut
On/Off

Low Cut Out

Equalizer

Low Cut In

+
-

80 Hz

Line/Instrument Input

140 - 3500 Hz

Main Mix L
Main Mix R

12 kHz

LEVEL

Main Meters

PFL

-15 to +15 dB -15 to +15 dB -15 to +15 dB

Solo
Level

Aux

-120 - +10 dB

FX

BALANCE LINE DRIVERS

(identical except
for USB Return on
5/6)

+

Mic +12 to +55 dB

Left

Main Output
Right

USB Send

Gain

Stereo Input Channels
3/4-5/6

-

USB Send 3/4-5/6

+

Main Right

-

Main Left

Send Level

+

48V Off
48V On

-

Send Level

+

48V

Pan

1/2

ADC
ADC

Signal
(green)

Clip
(red)

Master Bus USB Send 7/8

ADC

Master Bus USB Send 1/2

Mic Pre

[if Mono: Mains Splits to Left/Right. See ch 1-2]

(Channel 5/6 Only)
+10 dB Boost Off
+10 dB Boost On

Left (Mono)

Master Bus Send to SD Recorder

Equalizer

Main Mix L
Main Mix R

+10 dB
2.5 kHz

12 kHz

-15 to +15 dB -15 to +15 dB -15 to +15 dB

Pan

LEVEL

PFL
Mon

PFL
PFL

USB Return 3/4

DAC

Aux

Mon Out

+

80 Hz

Right

-

On/Off

Aux

[if Mono: PFL send Splits to Left/Right. See ch 1-2]

LEVEL

Level

-120 - +10 dB

Send Level

AFL

FX
Send Level

If Left/Mono only is connected, signal is sent to both Left/Right on Main Bus and Solo Bus
If Right only is connected, signal is sent to the Right side only on the Main Bus or Solo Bus

LEVEL

Super Channel
RCA Left

Main Mix L
Main Mix R

RCA RIGHT

BALANCE

LEVEL
USB 1&2

USB Return 1&2

DAC

SD Playback 1&2

DAC

Aux

Level

Cue Level
(PFL/AFL Master)

-120 - +10 dB

Solo Bus L

Send Level

Solo Bus R
-120 - +10 dB

Global
(any solo)

PFL/AFL
Control Room Bus L

Monitor Level

-

SD 1&2

USB / SD Toggle

PFL

PFL
PFL

Control Room L

Control Room Out L

Control Room R

Control Room Out R

+

Control Room Bus R

-

-120 - +10 dB

+

STEREO 1/8”

Bluetooth
Phones Level
-

Phones Output

+
+

-120 - +10 dB

+

FX Bus Send

FX Out

FX Out

FX Engine

FX Bus Return L
FX Bus Return R
BALANCE

LEVEL

Footswitch
(FX Mute)

Aux

NOTE: All switches are shown in the default (up) position

Main Mix L
Main Mix R
Solo Bus L
Solo Bus R
Aux
FX

Send Level
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Recall Sheets

8.3.1 AR16c and AR12c Recall Sheet
CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER
INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC

ADDITIONAL NOTES

CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER CHANNEL NUMBER
INSTRUMENT/MIC INSTRUMENT/MIC
Stereo
Stereo
Mono
Mono

INSTRUMENT/MIC INSTRUMENT/MIC
Stereo
Stereo
Mono
Mono

SOURCE

NOTE

NOTE

NOTE

NOTE

NOTE

NOTE

NOTE
NOTE

CARD NAME

ENTER
PRESET NUMBER
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8.3.2 AR8c Recall Sheet

INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC INSTRUMENT/MIC

SOURCE

NOTE

NOTE

NOTE

NOTE

NOTE

CARD NAME

ENTER
PRESET NUMBER
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Technical Specifications

Microphone Preamp
Type 		

XLR Female, Class A XMAX

Maximum Input level (unity gain)		

+9 dBu +/- 1.0 dB

Gain Control Range		

43 dB (+12 to +55 dB)

Frequency Response to Analog Outputs		

20 Hz to 20 kHz, +0.5/-1.5 dB

Frequency Response to USB (Direct)		

20 Hz to 20 kHz, +0.5/- 1.5 dB

S/N Ratio to Outputs (+4 dBu)		

94 dB

THD+N (min. gain, A-wtd) 		

< 0.01%

Input Impedance 		

1 kΩ

EIN (+55 dB gain, 150Ω input, 20 Hz-22 kHz, A-wtd)

< -128 dBu

Common Mode Rejection Ratio (1 kHz, +55 dB gain)

65 dB

Phantom Power 		

+48 V, ±3V, Global

*Note: All channel inputs sum through mic preamp.

Instrument Inputs
Type 		

¼” TS Female, Unbalanced, Hi-Z

Maximum Input Level (min. gain, 1 kHz@0.5% THD+N)

+9 dBu ±1.0 dB

Gain Control Range		

43 dB (+12 to +55 dB)

Frequency Response to Analog Outputs		

20 Hz to 20 kHz, +0.5/-1.5 dB

Frequency Response to USB (Direct)		

20 Hz to 20 kHz, +0.5/-1.5 dB

Dynamic Range (min. gain, A-wtd) 		

> 105 dB

Dynamic Range (mid. Gain, unwtd) 		

> 108 dB

THD+N (1 kHz, -1 dBFS, A-wtd) 		

< 0.01%

THD+N (1 kHz, -1 dBFS, unwtd) 		

< 0.01%

Input Impedance 		

> 1 MΩ

*Note: All Channel Inputs sum through Mic preamp.

Line Inputs
Type 		

¼” TRS Female, Balanced

Maximum Input Level (min. gain, 1 kHz@0.5% THD+N)

+26 dBu +/- 1.0 dB

Gain Control Range		
		

Mono Channels: 40 dB +/- 1.0 dB (-5 to +35 dB),
Stereo Channels: 0 dB or +10 dB (+10 dB Boost)

Frequency Response to Analog Outputs 		

20 Hz to 20 kHz, +0.5/-1.5 dB

Frequency Response to USB (Direct)		

20 Hz to 20 kHz, +0.5/-1.5 dB

S/N Ratio to Analog Outputs (+4 dBu)		

85 dB

THD+N (1 kHz, -1 dBFS, A-wtd) 		

< 0.01%

Input Impedance (Balanced)		

10 kΩ
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Main, Control Room, Aux, and FX Outputs
Type (Main Outputs)		

XLR Male, Impedance Balanced

Type (Control Room, Monitor, FX Outputs)		

¼” TRS Female, Balanced

Rated Output Level (Main Outputs)		

+24 dBu, ±1.0 dB

Rated Output Level (Control Room, Aux, FX Outputs)

+18 dBu

Frequency Response 		

20 Hz to 20 kHz, +0.5/-1.5 dB

Dynamic Range (A-wtd) 		

> 108 dB

THD+N (Bandwidth 20~20 kHz, -1 dBFS, unwtd)

< 0.01%

Output Impedance 		

100 Ω

Headphone Output
Type 		

¼” TRS Female, Stereo, Unbalanced

Maximum Output Level 		

150 mW/channel @ 56Ω

Frequency Response 		

20 Hz to 20 kHz, +0.5/-1.5 dB

Dynamic Range (a-wtd) 		

> 103 dB

THD+N (Bandwidth 20~20 kHz, -1 dBFS, unwtd)

< 0.01%

System Crosstalk
Input to Output (Ref = +4 dBu, 20 Hz to 20 kHz, unwtd)

-90 dBu

Adjacent Channels (Ref = +4 dBu, 20 Hz to 20 kHz, unwtd)

-85 dBu

Signal Level LED
Signal		

-30 dBFS (pre-EQ)

Clip 		

-3.0 dB before clip (pre- or post-EQ)

Channel EQ
Low Cut		

100 Hz, -18 dB/octave

High Shelving		

±15 dB @ 10 kHz

Mid Peaking (Mono Channels: AR16c, AR12c)		

±15 dB @ 140 Hz to 3.5 kHz (variable)

Mid Peaking (Stereo Channels: AR16c, AR12c, All: AR8c)

±15 dB @ 2.5 kHz

Mid-Band Q		

Boost: 1.0, Cut: 2.5

Low Shelving		

±15 dB @ 100 Hz

Audio Interface
Host Interface		

USB 2.0

ADC Dynamic Range (Component)		

114 dB

DAC Dynamic Range (Component)		

114 dB

Signal to Noise (A-wtd)		

-96 dB

Bit Depth		

24-bit

Internally Supported Sample Rates 		

44.1, 48, 88.2, 96 kHz

Jitter		

<80 ps RMS (20 Hz – 20 kHz)

Jitter Attenuation		

>60 dB (1 ns in => 1 ps out)

69

8
8.4

StudioLive™ ARc Series
Owner’s Manual

Resources
Technical Specifications

SD Recorder
Supported Media Format		

FAT16-formatted SD Card, FAT32-formatted SDHC Card

Media Storage Capacity		

SD Card: 2 GB, SDHC Card: 32 GB

Recording File Format		

Stereo WAV

Playback File Formats		

Stereo WAV, MP3

Sampling Rate (WAV)		

44.1 kHz

Bit Depth		
		

Recording: 24-bit,
Playback: 16- and 24-bit

Power
Connector		IEC
Input Voltage Range		

90 to 240 VAC

Physical		

AR16c

AR12c

AR8c

Length		

15.6” (397 mm)

15.6” (397 mm)

12.3” (313 mm)

Width (chassis only)		

18.9” (480 mm)

15” (381 mm)

11” (284 mm)

Maximum Height		

3.5” (89 mm)

3.5” (89 mm)

3.5” (89mm)

Weight		

14.1 lbs (6.4 kg)

11.9 lbs (5.4 kg)

7.1 lbs (3.2 kg)

Global Warming
Recommended Ambient Operating Temperature 0˚ to 40˚ Celsius / 32˚ to 104˚ Fahrenheit
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Troubleshooting

9.1

Troubleshooting
Please check the PreSonus Web site (www.presonus.com) regularly
for software information and updates, firmware updates, and support
documentation, including frequently asked questions.
Online technical support is available from within your My PreSonus account.
PreSonus telephone technical support is available to customers in the USA on
Monday through Friday from 9 a.m. to 5 p.m. Central Time by calling 1-225216-7887. Customers outside of the USA should contact their national or
regional distributor for telephone technical support. A list of international
distributors is provided at www.presonus.com/buy/international_distributors.

No Output on a Channel
Check the signal-present LED and verify that there is signal on that channel. If no
signal is present, check the cable and the input source. Verify that the trim control
is set at an appropriate level. Make sure the channel is not muted. Make sure that if
your device requires phantom power, phantom power is engaged for the channel.
No Output on the Solo Bus While Monitoring
Verify that both the Cue volume and the headphone, or monitor,
volume is at a reasonable level for comfortable listening and that
the PFL button is engaged on the desired channels..
Can’t Hear Main Mix in Headphones
Verify the headphone output control is at a sufficient level.
Make sure that no PFL or AFL buttons are engaged.
Control Room Level Not Affecting Volume
Verify that your monitors are connected to the Control Room
outputs of your StudioLive ARc, not the Main outputs.
Main Fader Doesn’t Control Mix Level
Verify that your monitors are connected to the Main
outputs, not the Control Room outputs.
Microphone Preamp 1 or 2 Doesn’t Pass Audio
First, verify that the Instrument input button is not engaged. This disables
the microphone preamp. Next, verify that your microphone cable is
operational and that the trim control is set at an appropriate level.
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Dinner is Served

Added bonus: PreSonus’ previously Top Secret recipe for…
Chicken and Andouille Gumbo
Ingredients:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

1 C All-Purpose flour
¾ C Vegetable Oil
1 large onion (diced)
1 small onion (quartered)
6 celery stalks (diced)
1 large green bell pepper (diced)
3 cloves garlic (2 minced, 1 whole)
1 lb link Andouille sausage
4 Chicken leg quarters
4 qt water
4 bay leaves
1 tsp thyme
1 tsp Old Bay seasoning
1-2 C frozen okra, sliced
¼ C fresh parsley, minced
6-8 eggs (optional)

Cooking Instructions:
1.

2.
3.

4.
5.
6.
7.
8.
9.
10.
11.
12.
13.

In a large pot, combine whole chicken leg quarters, water, quartered onion, Old Bay, 2 bay leaves and 1 whole clove garlic.
Cover and bring to a low boil. Simmer stock until chicken is falling off the bone. Remove the chicken and set aside. Discard
the onion, bay leaves, and garlic, reserving the liquid.
In a heavy saucepan, heat 1 Tbsp of the oil on medium high heat and brown the andouille until it is cooked through. Set
aside sausage for later.
In the same saucepan, add and heat remaining oil. Slowly add flour 1-2 Tbsp at a time, stirring continuously. Continue
cooking and stirring the roux until it is a dark brown (it should look like melted dark chocolate). Be careful to not to get the
oil too hot or the flour will burn and you’ll have to start over.
Once roux has reached the correct color, add diced onion, celery, green pepper, and minced garlic. Cook until vegetables
are very tender. Do not cover.
Slowly add 1 quart of chicken broth and bring to a low boil, stirring constantly.
Transfer roux mixture to a soup pot and bring to low boil. Do not cover, the roux will settle on the bottom of the pot and burn.
Add remaining chicken broth, bay leaves, and thyme. Simmer for 30 minutes.
While gumbo is simmering, debone and shred chicken and slice the andouille.
Add chicken and andouille to gumbo and return to a simmer. Simmer for 30-45 minutes.
Stir in frozen okra and parsley and bring to a rolling boil.
Optional: Crack one egg into a teacup and quickly pour into the boiling gumbo. Repeat with the other eggs being careful
not to cluster them too closely. After all the eggs have risen back to the surface, reduce heat and simmer.
Correct seasoning with salt and pepper (red, white and/or black) if necessary.
Serve over rice with potato salad.

Serves 12
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